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FCC NOTICE

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses, and can radiate radio frequency and energy and, if not installed and used
in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guar-
antee that interference will not occur in a particular installation. If this equipment does does cause harmful interference
to radio or television reception, which can be determined by tuming the equipment off and on, the user is encouraged to
try to correct the interference by one or more of the following measures:

» Reorient or relocate the receiving antenna

* Increase the separation between equipment and receiver

* Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
» Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications not expressly approved by Brother International Corporation could void the user’s authority to
operate the equipment.

DOC NOTICE

This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus set out in the
radio interference regulations of the Canadian Department of Communications.

Le présent appareil numérique n'émet pas de bruits radioélectiques dépassant les limites applicables aux appareits num-
ériques de la classe B prescrites dans le réglement sur le brouillage radioélectrique édicté par le ministrére des Commu-
nications du Canada.

COPYRIGHT AND TRADEMARK NOTICES

INTERNATIONAL CORRECTSPELL® Spelling correction system licensed from INSO Corporation. US Pat. Nos.
4,580,241; 4,730,269; 4,771,401, Copyright® 1985, 1987, 1988 by INSO Corporation: All rights reserved. Reproduction
or disassembly of embodied algorithm or database prohibited. Roget’s Il Electronic Thesaurus, portions® 1985 INSO Cor-
poration. All rights reserved. Reproduction or disassembly of embodied algorithm or database prohibited. Roget's I The
New Thesaurus® 1980 by Houghton Mifflin Company.

MS-DOS and WINDOWS are registered trademarks of Microsoft Corporation.
IBM and PC-DOS are registered trademarks of International Business Machines, Inc.
Lotus® and 1-2-3® are registered trademarks of Lotus Development Corporation.

Clip Art Images in this product are licensed from Media Graphics International and are protected by US and worldwide
copyright laws.

The photos used in this product are the copyright of Master Clip® Premium Image Collection. Master Clip is copyrighted
and a registered trademark of ©IMSI 1997 All Rights Reserved.

Copyright 1989. Jeffery L. Saglin, based on the book AMA Handbook of Business Letters published by AMACOM Books,
a division of the American Management Association. All rights reserved. Used by permission of Nova Development Corpo-
ration, Calabasas, CA.

©1997 Brother Intemational Corporation. All rights reserved. All other brand and product names are trademarks or regis-
tered trademarks of their respective companies.

WARNING - FOR YOUR HEALTH

To Avoid repetitive motion injuries when using this keyboard, we recommend the foilow-
ing steps. Maintain a comfortable, straight wrist position when typing. Take breaks, at
least every hour, to stretch hands and arms. Report any pain or other symptoms to your
physician.
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Getting Started
-

This chapter provides general information about your Color Inkjet Desktop
Publisher and its software. The topics covered are:

* . Parts

* Precautions

* Setup

* Paper Feeder

* Inkjet Cartridge

* Diskettes

¢ Keyboard

* Operation Overview

* Supplemental Programs

The remaining chapters describe each of the programs available on the
Desktop Publisher. The Appendix provides clip art samples, technical data,
and troubleshooting charts. A Glossary is included that defines terms used
throughout the manual.

How to Use This Manual

Information in this column Notes are located in the left-hand column. They provide facts that help you
describes helpful hints, use your Desktop Publisher more efficiently. An example note is located to

restrictions, and ways to avoid .
difficulties. the left of this paragraph.

Please pay close attention to the CAUTION and WARNING notices in this
manual. They alert you to potential damage to your Desktop Publisher or
danger to yourself. The examples below show you what the CAUTION and
WARNING notices look like.

CAUTION.
Failure to pay attention to caution notices can result in damage to the
equipment or loss of valuable data in the memory or on the diskette.

WARNING:
Warnings are for your safety. Failure to pay attention to warning
information can be dangerous to you and others.
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Parts of Your Desktop Publisher

Latch

Top cover\ \

f
~~~~~

Power switch

DC connector

DC plug

Sub paper support

LCD screen

Paper support

LCD contrast control
Keyhoard

Diskette eject button

Disk drive

Light
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Precautions

«

WARNING:

Do not try to take apart or repair this equipment yourself. Service
should be performed by authorized Brother service personnel only.
Warranty will be voided if you take the unit apart.

WARNING:

If the glass screen appears to be cracked, do not touch it. You may cut
yourself. Carefully wrap the unit in its box and take it to authorized
Brother service personnel only.

CAUTION:

Do not pull on tﬁe power cord. To disconnect it, always grasp the
plug itself.

Avoid direct exposure of the equipment to sunlight and other
sources of heat, excessive moisture, or dust.

If you spill any liquid onto the equipment, immediately unplug the
system and consuit authorized Brother service personnel only.

Do not use sprays in the vicinity of the Desktop Publisher.
Aerosols are extremely harmful to the disk drive.

Unplug the equipment during a thunderstorm.
Do not place heavy objects on the keyboard.

Keep the back and sides clear of obstructions to prevent
overheating.

Use only a soft, dry cloth to clean the equipment (do not use
chemicals, solvents, or detergents).

To avoid electrical interference, do not place the Desktop
Publisher close to a radio receiver or television. If the Desktop
Publisher is close to a television, the disk drive may not work
properly.

If you turn the Desktop Publisher off, wait at least 10 seconds
before turning it on again. Failure to wait 10 seconds may disrupt
the start-up sequence, resulting in faulty operation and possible
hardware damage.

Do not turn the Desktop Publisher off while printing.

Do not touch any metal parts inside the printer unit. These parts
become hot in the printing process.

Make sure the inkjet cartridge (under the top cover) has moved
back to its leftmost position before you turn the power off. If you
notice that the cartridge has not moved to its leftmost position,
turn the power on again and iet the cartridge move to the correct
position. Then turn the power off.
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» After installing the inkjet cartridge in the Desktop Publisher,
never move the inkjet cartridge from side-to-side with your

hands.

* Close the LCD cover gently until you hear the click when
transporting or storing the machine.

Setup

WARNING:
Do not plug your Desktop Publisher into an electrical outiet until you

have completely assembled it.

WARNING:
To prevent pinched fingers, keep fingers away from both bottom and

sides of the LCD screen when you change your screen’s viewing angle.

1. Pull the cover latch toward you, and lift the screen display to open.

2. Connect the DC plug into the DC connector.

N

N\ =

Power switch

DC connector

DC piug

3. Plug the AC adapter into an electrical outlet.
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4. Press the power switch on the left rear side of the Desktop Publisher
to turn it on. If the Desktop Publisher does not respond, check the
AC adapter.

5. Use the control on the right side of the LCD screen to adjust screen
contrast until the characters on the screen are easy to read.

6. Remove the packing from the output tray prior to printing.

Paper Feeder

A paper feeder is built into your Desktop Publisher. The paper feeder
allows you to load up to 30 sheets of letter or A4-size paper for automatic
feeding.

p-To set up the paper feeder:

1. Flip open the paper support on the back of the machine and pull up
the sub paper support.

If you use the transparency or 2. Pull the paper release lever on the right side of the printer toward
iron-on transfer papet in high you as shown above. To print thick (24 lbs.) paper, labels,
temperature o high humidy transparency, iron-on transfer paper, or envelopes, pull the lever on
conditions, place a regular sheet . el . " elow:

of paper on the back surface of the right side of the printer toward you as shown below:

the transparency or iron-on
transfer paper before loading
them into the paper feeder.

3. Pick up no more than 30 sheets of letter or A4-size paper.
4. Fan the paper before loading as shown in the illustration on the left.
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Paper recommendations:

high quality bond, 16-24 b.
Paper does not feed properly if
there is too much paper in the
paper support.

Do not exceed the 30-sheet
fimit of letter or A4 paper, or the
5-set limit of COM10 or DL
envelopes.

Avoid using glossy or slick
paper and envelopes with a
sticky seal in the paper stippori,
because it can cause paper
jams.

Up to 15 printed sheets can be
stacked in the machine.
Remove all paper from the
machine when you reset the
paper.

Use only one type of paper at
a time.

If you use envelopes, change
the Envelope Print setting on
the Print menu to Yes. See
page 66 for more details.

5. Load the paper into the paper feeder.

6. Align the paper with the right tab and slide the left tab over until it
touches the edge of the paper.

7. Tap the left and top edges of the paper stack to align the edges.
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Up fo 10 sheels of letter- or
Ad-size paper, orup to 5
envelopes, can be stacked in the
paper tray.

Pull the sheets toward you as
shown below until the edgs of the
paper exits the machine
completely.

Be sure to store the handle firmly
in its original position while
printing. Otherwise, the handle
will obstruct the path of the paper
and cause it to jam.

8. Push back on the paper release lever (on the left side of the paper
feeder) to hold paper tightly against the rollers.

9. The paper exits from under the keyboard when printing is
compileted.

If you use small paper or envelopes, lift up the machine gently and
pick up the paper.
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If the paper is jammed in the machine, remove the paper from the
paper support (after pulling the paper release lever toward you), or
open the top cover and remove the jammed paper. If it is still
difficult to remove, open the paper tray as shown below:

P To eject paper from the paper feeder:

Press CODE + SHIFT + HELP. The paper ejects from the front of the
Desktop Publisher.

About Landscape Printing

This machine has landscape printing capability. Select Letter or A4
Landscape in the Page Setup mode (see page 50) when you wish to print
the information in this way. The machine automatically switches from
Portrait to Landscape mode and back again according to the Page Setup
settings.
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Inkjet Cartridge

Use only Brother inkjet
cartridges.

Use a black cartridge for black
text and save the color cartridge
for color printing only. The
system detects whether you are
using black or color ink; you do
not need to change any ssfting
when you change cartridges.

WARNING:
Keep used and new inkjet cartridges out of reach of children. Avoid
contact between cartridge and face, eyes, skin, and clothing.

Your Desktop Publisher uses a replaceable inkjet cartridge that contains
both the print head and ink. Replace the cartridge after approximately
1,000,000 characters (estimate based on using normal text in 12 point,
Brougham font with monochrome printhead).

Follow these precautions to ensure maximum life of your inkjet cartridge:

Install the cartridge immediately after you remove the tape from it. If
you set the cartridge aside for an extended period, the cartridge head
may dry out.

The head of the cartridge is covered with wet ink. Never touch the head
of the cartridge and never let it touch any other surface.

Store the used inkjet cartridge in the cartridge holder to prevent drying.

To prevent leakage from the print head, do not shake the cartridge after
it has been removed from its pack.

Store the new inkjet cartridge in the same environment as the Desktop
Publisher.

Do not expose cartridges to direct sunlight. Store them at a temperature
lower than 40° C (104° F).

To transport the Desktop Publisher by air, take out the inkjet cartridge
and install 2 new one at your destination.

To move the unit, handle it carefully. Do not jar or turn it sideways with
an inkjet cartridge in place.

We recommend that you use cartridges within one year of installation to
assure high print quality.
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Installing/Replacing an Inkjet Cartridge

In this section, you will learn how to install an inkjet cartridge and replace
a used one.

P> To install the first inkjet cartridge:

When you set up yotir Desktop 1. Turn th i

Publisher for the first time, you ’ nthe Desktop Publisher on.

need to install the inkjet 2. Press CODE+ INK CHG. The inkjet cartridge bracket moves to its ink
cartriage. - change position (right side). Do not move the cartridge bracket

manually from side-to-side. This message appears:

Proceed to change the ink cartridge.

After changing the ink cartridge, press RETURNM.

3. Pull the LCD screen forward.

You have 5 minutes to install or
change the inkjet cariridge before
the bracket automatically returns
{o the left-hand posifion.

5. Tear open the inkjet cartridge pack and remove the new cartridge.

6. Carefully remove the protection tape from the print head before
installing. Do not shake the inkjet cartridge after the protection tape
is removed. Do not remove the metal contacts from the cartridge.

Protection tape
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Keep dust out of the print head i i i i inki :
by acing i rmly 1 e 7. IShtde .the .mk ca}rmdge into the inkjet cartridge bracket so that the
cartridge. ettering is upside down.

You wiif not be able to print if the

8. Squeeze the inkjet cartridge bracket and cartrid i
cartridge is not correctly locked. 4 4 8 ge together until the

cartridge snaps under the latch on the bracket.

9. Close the top cover.
10. Press RETURN. The inkjet cartridge is ready to use.

p-To replace a used inkjet cartridge:

1. Press CODE+ INK CHG. The cartridge moves to the right, which is the
ink change position. Do not move the cartridge manually from
side-to-side. This message appears:

Proceed to change the ink cartridge.

Alter changing the ink cartridge, press RETURN.
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You have 5 minutes to install or 2. Pull th i

! . e LCD
change the inkjet cartridge before dlSpIaY forward,
the bracket automatically returns
to the left-hand position.

3. Open the top cover.

4. Grasp the inkjet cartridge as shown below and push backward (1).
Then pull the cartridge straight up (2). To avoid getting ink on
your hands, do not touch the bottom of the cartridge.

To protect the head from dust or
from drying out, squeeze the
inkjet cartridge untif you hear a
click.

5. Dispose of the old cartridge immediately, or store it in the cartridge

holder as shown on left.
6. Tear open the inkjet cartridge package and remove the new cartridge.

Getting Started 12



7. Carc—;ﬁ;lly remove the protective tape before installing. Do not shake
the inkjet cartridge after the protective tape is removed. Do not
remove the metal contacts from the cartridge.

8. Slide the inkjet cartridge into the cartridge bracket.

Protective tape

Yo; Egﬂ not be able to print if the 9. Squeeze the inkjet cartridge bracket and cartridge together until the
cartridge is not correctly locked. cartridge snaps under the latch on the bracket.

10. Close the top cover.

11. Press RETURN. The inkjet cartridge is ready to use.
Cleaning the Print Head

From time to time, you may need to clean the print head. You should
clean the print head when

* the ink on the page looks splotchy or messy.
* blank spaces appear on the page.

To clean the print head automatically, press CODE + SHIFT + INK CHG. 7he
cartridge moves slightly to the right and then back to the left.

: Getting Started 13



If print quality does not improve
after cleaning the print head,
please remove the inkjet
cartridge and install it again. If
print quality is still not good, the
problem may be caused by dried
ink on the nozzles, contacts, or
the print cartridge bracket
contacts.

Do not use a paper tows! for
cleaning because it can leave
tiny fibers that clog nozzles and
cover contacts.

Do not use a paper towel for
cleaning because it can leave
tiny fibers that clog nozzles and
cover conlacts.

pTo clean the print nozzles and contacts:

1.
2.

3.

Remove the inkjet cartridge. (See instructions on page 11)

Gently clean the entire copper-colored area, including the nozzles
and contacts with a clean cloth, dampened with water only.

To dissolve any dried ink, hold the damp cloth against the nozzles for
about three seconds. Gently blot and wipe dry.

Allow the copper-colored area to dry.

4. Reinstall the inkjet cartridge and press RETURN. Then press CODE +

SHIFT + INK CHG and close the cover.

If the Desktop Publisher is still not printing correctly, clean the
bracket contacts in the printer.

p>To clean the bracket contacts in the printer:

1

Press CODE + INK CHG to move the inkjet cartridge bracket to the
right side of the printer unit.

. Without turning the Desktop Publisher off, unplug the DC plug from

the DC connector on the left side of the Desktop Publisher. (This -
keeps the inkjet cartridge in the right-hand position.)

Turn the power switch off.
Remove the inkjet cartridge. (See page 11.)

5. Use a clean, dry cloth to clean the contacts on the inside of the inkjet

cartridge bracket.

Bracket contacts for
the inkjet cartridge

6. Install the inkjet cartridge.
7. Plug the DC plug into the DC connector on the left side of the

8.
9.

Desktop Publisher.
Turn the power switch on.
Press CODE + SHIFT + INK CHG.

If print quality does not improve after this cleaning process, replace the
inkjet cartridge. If print quality still does not improve, your printer may
require service. Contact your local authorized Brother service personnel

only.
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Diskettes

Your Desktop Publisher uses both MF-2HD (High Density) and MF-2DD
(Double Sided/Double Density) diskettes. The MF-2DD have half the
capacity of the MF-2HD. We recommend that you use Brother diskettes.

The slightest damage, such as a scratch or a small amount of dust on a
diskette, can easily spoil an entire file and make it unreadable. The
protective case of the 3.5 inch diskettes prevents, to some extent, damage
to the sensitive diskette surface. (The metallic shutter automatically opens
and exposes this sensitive surface only when the diskette is inserted into
the drive.) However, additional precautions must be taken to ensure
reliable maintenance of your files.

CAUTION:
» Never open the shutter of the diskette.

« Never touch the surface of the material inside of the diskette.
« Do not use magnetic materials near the diskette.

« Never expose the diskette to extremely high or low temperatures.

Inserting and Removing a Diskette

CAUTION:
Never remove a diskette while a screen message or the LED

indicates that a disk operation is in progress.

To insert a diskette: Insert the diskette as shown in the illustration below.
If you insert it the wrong way, you will feel some resistance.

%

To remove a diskette: Press the eject button.

Insert
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Initializing (Formatting) New Diskettes

CAUTION:

Initializing a diskette erases all information on it.

Diskettes must be formatted before they can be used. Some diskettes are
already formatted as IBM compatible when you buy them. However, if you
buy unformatted diskettes, your Desktop Publisher can format them to be
IBM compatible. The diskettes you use on a Desktop Publisher can also be
used on a personal computer. This Desktop Publisher can read and write
diskettes formatted on a personal computer in the DOS 1.44 MB
(megabyte) format and the DOS 720 KB (kilobyte) format,

When you insert a diskette and try to save a file on it, the Desktop
Publisher checks the format of the diskette. An error message tells you
what to do if the diskette matches any of the following conditions:

* The diskette is unformatted (new).

* The diskette is formatted, but not with an MS-DOS-compatible format.

P To initialize a diskette:
1. Insert a diskette into the disk drive.

2. Create your document and press MENU to show the menu bar;
choose Save File from the File menu. 7his message appears:

Unformatted or darmaged disk!
Do you want to initialize digk?
Aall data on disk will be deleted ifinitialized.

[vES]

P to selactand press HETUIRRM,

)]

3. Select YES to initialize or NO to exit; press RETURN. If you select
YES, this dialog box appears:

<« FORMAT TYPE >>

Use cursor to select and press RETURN.

4. Select the type of format that matches the diskette and press RETURN
to initialize the diskette. This dialog box appears:

0

< < INITIALIZE DISK > >

FORMAT TYPE: 1.44MB
INITIALIZED %:

50

100
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Write-Protecting Your Diskettes

All 3.5 inch diskettes have a switch that protects their contents from
accidental erasure. When the switch is in the READ ONLY position, you
cannot erase old information or store new information on the diskette.
Slide the switch to the READ ONLY position to protect a diskette
containing valuable information. (The switch is in the READ ONLY position
when it leaves a hole in the diskette cover that you can see through.) You
can slide the switch back to the WRITE position when you want to change
files or add new files to it.

oy

Write/Read

If you have a diskette in the READ ONLY position, this dialog box appears:

Write protected disk! X
Flelease the protection or insert ancther disk and retry.

Use cursor o select and press RETURN.L
[CAMNCEL]

Backing Up a Diskette

The best insurance against losing important information is to make
backups (duplicate copies) of important files. To learn how to make

backups, see Making a Backup Copy of a Diskette on page 86.
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Keyboard

Your keyboard contains both the character keys of a standard typewriter
and special function keys. Many keys also have second or third functions
that can be accessed when you press the key combined with another key.
The plus sign (+) is used with key names to show these key combinations
in instructions. When you see these key combinations, press and hold
down SHIFT or CODE; then press the second key. For example, SHIFT + A
means to press and hold down SHIFT, and then press A.

Character Keys and Arrow Keys

o |
+

TAB Q w E
PIND <

/

The character keys are the keys found on the standard keyboard, and the
arrow keys are the keys for moving around in your text.

] @ % e =
i 3 3 i 5 % 7 8 9{@ ]0 ~ l PRINT lNSEﬂ CANCELY MENUY HELP
TsTYLEL FonT JcoLon | symeol E cHAR NUM-L INK CH LAYOUT l | Ip EREAJ

R T |Y @[ 1G] oGl P @ + [ BACKSPACE
1 > + ]

CAPS

sHFTLOCK] A | § ID FIG H [0 «k@fL )

GOTO H ’ RETURN

C_IiT:

c

Tv B N M ' .G }’m SHIFT oL EN

—
RELOC

NEXT 8

=1

3 )
DELETE jwoRD 0
LINE DUT

The character keys and some
function keys automatically
repeat if you hold the key dowr.
This is useful when you want to

3

type something like = — —— — \

Pressing SHIFT when in the
Caps Lock mode alternates
between SHIFT LOCK and Caps
Lock.

Letter keys. Pressing the key alone gives the appropriate lowercase letter.
Pressing the same key while holding SHIFT down gives the appropriate
capital letter (SHIFT + A = “A"™).

Other character keys. Pressing the key alone gives the character
indicated on the middle of the key (1 = “1”). Pressing the same key while
holding down SHIFT gives the character indicated on the upper-left corner
of the key (SHIFT +1 = “I").

Special characters. Characters indicated in green on some keys can be
obtained by pressing CODE + the key (for example, CODE + W = “<™).

Shift Lock mode. You can type capitals and the special characters above
the number keys without holding down SHIFT. If you press SHIFT LOCK,
the SHIFT indicator is highlighted at the right of your screen. Now all the
characters you type are uppercase, or the special characters above the

number keys appear (A = “A,” 1 = “1"). To release this mode, press SHIFT,

Caps Lock mode. When you want to type only capital letters and numbers
like “ACCT. NO. BC104,” press CODE + CAPS. The SHIFT indicator at the top
of the screen changes to CAPS (highlighted). Caps Lock mode turns on so
that you enter only capital letters. To release this mode, press CODE + CAPS

again.
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Keypad Keys

Arrow keys. Pressing T, L, «, and - allows you to move the text cursor
one position in the dlfeCtIOﬂ of the arrow on the key.

These keys can be used like a calculator keypad when the Numeric Lock
mode is active.,

N

I

Function Keys

Numeric Lock mode. When you need to type numbers only, press CODE
+ NUM-L to lock the keyboard in the number mode. The Numeric Lock
indicator (ft) at the top of the screen is highlighted.

When the Numeric Lock indicator (#) is highlighted, you can type the
characters in the black boxes on the keys. (See illustration above.)

To release the Numeric Lock mode, press CODE + NUM-L again.

In addition to the normal character keys of a standard typewriter, your
keyboard features 2 number of function keys.

CANCEL} MENU | HELP

RETURN
COL END
I S HE\.D\':

Jﬂ:sm osm ou
\ LINE ou

RETURN. This is the “action” key. When selecting from a menu or
answering a question from the Desktop Publisher, pressing RETURN allows
you to continue.

CANCEL. This is the “exit” key. When selecting from a menu or answering
a question from the Desktop Publisher, pressing CANCEL allows you to
return to the previous step. Each time you find yourself in the middle of an
operation you want to stop, press CANCEL.
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MENU. This key allows you to see the menu bar at the top of the screen.
Once it appears, select the function you want to start.

CODE. You can use functions labeled in green on the keyboard by
pressing CODE. To start these functions, hold down CODE and then press
the function key.

Most of the character keys on your keyboard can start a function when
pressed together with CODE. For example, when you press CODE + G, the
GO TO function is turned on. GO TO is printed in green at the bottom of
the key.

Many functions, however, are not indicated with green letters. For
example, CODE + J turns the Justify function on and off in the Word
Processing program. Pressing HELP gives a list of these short-cut functions
and an explanation of function keys.

Most noncharacter keys have two names: the upper name indicates the
function that starts when you press the key alone, and the lower one
indicates the function that starts when you press the key together with
CODE (example: HELP and CODE + P BREAK).
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Selecting Programs

Main Menu

Program description

Starting a program

When you turn on the Desktop Publisher, this Main Menu appears:

il

By -:'
File
Managernent Meut Sereen

Disk
Application

Frame FPrint Pre Screen

A short description of the different programs you can start from the Main
Menu follows:

Word Processing. Creates and edits documents, complete with tables and
graphics.

Addressbook. Creates and edits lists, such as addresses and phone
numbers.

File Management. Organizes files on a diskette.

Graphic Art Print. Allows you to print monochrome and color images
supplied on diskette.

Frame Print. Prints special outer frames onto the page.

Disk Application. Starts additional programs that come with your Desktop
Publisher.

Next Screen & Pre Screen. Switches the menu and displays the different
icons that can be selected. The menu switches to another one by moving
the block cursor onto this icon.

There are two ways to start a program. Use the method you find most
comfortable.

Press the number key on the icon {1 for Word Processing, etc.).

OR
1. Press the arrow keys (¢, —, T, and 1) to move to a program icon.

2. Press RETURN to start the program. The program menu appears.
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Function Menus

All functions in the programs are found in menus. Press MENU to show the
menu bar at the top of the screen; then select a function to start it.

Accelerator keys. Each item of the menu has a single underlined
character. You can select items from the menu faster by pressing the
corresponding letter on the keyboard.

Short-cut keys. With many functions, you can use short-cut keys. For
example, the short-cut keys for the Justify function are CODE + J. The
menu bar does not appear, but the justification function becomes active
immediately. The HELP screen gives the list of short-cut keys that can be
used in each mode.

Help Windows
Press HELP and a HELP dialog box lists short-cut keys available at that
time. After getting your information, press CANCEL to close the HELP
dialog box.

Self Demo

Press CODE + D to see and print out the main features of your Desktop
Publisher.
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Supplemental Programs

Programs compatible with this system come on diskettes and can be
started by selecting the Disk Application icon on the Main Menu. The
programs on diskette that come with your Desktop Publisher are listed

below.

Conversion
This program allows you to convert documents between different word
processing formats and your Desktop Publisher format. For more
information, see Conversion in the Appendix.

Tutorial

This program teaches you how to use Word Processing.

We recommend you look at these programs before you start using Word
Processing. See the next page for a sample of a document created with the

tutorial. For best results, refer to this sample document as you go through
the tutorial. To start the tutorial, see To use the tutorial on page 98.
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This page contains a sample document created with the tutorial program,
For best results in creating this sample, refer to this page as you go
through the tutorial.

Published by The Springfield Homeowners Association

Spnngfield Welcomes Fred & Lesle Tanner

As you may have heard, the
Taylor house at 117 Elm has finally
been sold!

Our new neighbors, Fred and
Leslie Tanner, said they fell in love
with the Taylor house the moment
they saw it.

Fred is an Executive Vice-
President at Alliance Electronics in
Middletown. Because he played
college basketball, he plans to get
involved with our high school team,
the Springfield Sabers. Befter not let
Couch Wilson hear about that!

Springfield Taxes Lowest In County
For Third Year In A Row

Leslie, who studied interior
design, hopes fo start a small
consulting practice out of her home
and offer her services to local
residents and businesses.

Her first project will be to tumn the
family room of her home into a
combination sunroom/office. In

Every time we step inlo a supermarket or department siore, it scems

as if the price of everything is always going up.

Fortunately, the sa:)e can't be said of our property taxes which 10000
have remained the county's lowest for three years in a row.

Usually, low property taxes are accompanied by reductions in
municipal services like police, fire and garbage disposal. But thanks 5000
to the ingenuity of Mayor Joseph Ash and the city council, our level
of municipal services has actually increased over the last few years.

*It's a result of all of us working together to maintain the high 2000 -
quality of life that Springfield residents have come to expect.

By Amanda Becker

Jenny, who studied ballet and tap,
plans to try out for the cheerleading
squad. Craig, who won "Best Pre-
Teen Player” at the All County
Tennis Tournament, plans to try out
for the Springfield Elementary tennis
team.

Needless io say, we're sure the

fact, she was already over to Drake's Tanners will be a welcome asset to
Lumber Yard to order new windows OuF community.
and fixtures. For those of you who haven't met
Their two children, Jenny and them yet, be sure to keep Sunday,
Craig, will be attending Springfield May 29th, open for the annual "Say
elementary starting this fall. Hello To Summer” barbecue.
By Don Addison
COMPARATIVE ANALYSIS
TAX AMOUNTS

Members of our mumicipal organizations are all Springfield residents
and realize that they are an important part of Springfield's big

picture”, said Mayor Ash.

Springfeld  Spring Woochridge

: Delton
TOWNSHP NAME
Wrax

Mayor Ash continued by saying that a large part of the thanks also should go to our various committees and councils
for their iniiative in creating money-raising events. ) )
One particular case that came to mind was the library committee which raised ower $25.000 in their annual "Cycic-

Thom”. As most of you probably remember, the "Cycle-Thon" took place last fall and bad over 300 participants, each
with their own "Dollar-A-Milc" sponsor. Because all administrative and promotional costs were donated, all the monies
raised were able to go directly 1o our library.

*Thanks to events like this, we are able fo maintain our high level of services without having to increase taxes on our
residents”, concluded Mayor Ash.
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1 word Processing

With Word Processing, you can create many documents, from business and personal letters to
student papers, newsletters, and fliers. Besides having a widle variety of basic features, Word
Processing includes some advanced features also, such as double column printing, and merge

printing.

You may create your own Word
Processing file or use one
already made for you. For delails,
see To Open a Template File on
page 98.

If you see a message indicating
you have an unformatted or
damaged diskette, replace the
diskette with another, or go fo
page 16 in Getting Started for
instructions on how to initialize a
diskette.

Remember that you can press
HELP to get on-screen help.

The particular version of Desktop
Publisher you are using may not
have alf the functions listed on
the Help Menu screen.

p>To create a new file:
1. From the Main Menu, press 1.

Word Processing \ f Addressbook 3\
KHEWTE =T

Select 3 tile and pres: RETIURMN. Presz CANCEL to select mode.

2. Select *NEWTEXT by pressing RETURN. (Later, you will use the
arrow keys to select a file from the list of files and then press
RETURN.) The Input/Edit screen shown on the next page appears.

p-To edit an existing file:
1. Insert the diskette with the file into the disk drive.
2. Press 1.

3. Use the arrow keys to select the file you want; press RETURN. 7he
Input/Edit screen shown on the next page appears.

p-To use the Help Menu:

Press the HELP key in the upper right-hand corner of the keyboard to see
the keyboard shortcuts and function explanations for each program. Press
CANCEL to remove the Help Menu from the screen.

[FeT 2 HNE w % PROLESS LG &

a. 1T . 2

Word Processing files are created, edited,
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Using the Word Processing Input/Edit Screen

1 2
| !

3 4 5 6 7 8 9 10 11 12
IIII_[—||IIIII

Status line — [BT__IHHE  TE T L@MJ&JJ@&UJ@. ity W-HU"@I

Scale —

Status Line. The status line (across the top of the screen) shows your
current settings. Reading from left to right, each item is described below:

1
2
3
4

L4,

10

11

12

Page Number—Gives the page number where the cursor is placed.
File Name—Gives the name of the file you are using.
Font —Gives the font currently being used.

Font Size—Gives the font size (in points) and Font mode (double
width or double height).

Font Color—Gives the text color.

Type Styles—Highlighted (framed with a solid lin€) if active. The
available type styles, from left to right, are bold, underline, strike-out,
italic, outline, shadow, superscript, subscript, and shading.

Attribute Color—Gives the attribute color (underline, strike-out, and
shading).

Spell Check—Highlighted (framed with a solid line) when Spell Check
is monitoring your typing.

Auto Return or Justify—Tells you when you are in either the Auto
Return (AUTO) or Justify JUST) mode.

Insert or Overwrite—Tells you when you are in either Insert (INS) or
Overwrite (OVER) mode.

Numeric Lock—Highlighted (framed with a solid line) when the
keyboard is locked in Numeric mode. (The keypad keys will be active.
For more information, see page 19 in Getting Started.)

Capital Lock (CAPS)—Highlighted (framed with a solid line) when the
keyboard is in the capital letter (CAPS) mode or in Shift (SHIFT) mode.
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;gﬁrii’:e’;’,";"'; r:”; ;ci’l‘: :e“’m Scale. This scale helps you to determine the position of characters on a
space for your text. page. The numbersl indicate the position from the left edge of the paper.
See Scale Line ONOFF on page ~ Qther symbols remind you of format settings: left margin [ [], right margin

65. {]]. normal tab[{], center tab [ ] leader tab [{], and decimal tab [y].

;‘;’ g‘;’sfz r’f;f;_':g’a;’;: 1:2 :;owng Text Area. Most of this screen is your work area; however, it only shows

CODE ey combinations, see part of your document at a time. To see the rest of your document, you

page 31, must use arrow keys (or combinations of arrow keys and the code key) to
move the viewing area up, down, left, and right. The only parts of the
screen you cannot use are the dead columns (left and right edges of the
screen). The Desktop Publisher reserves the left edge for the Format
Change symbol [E], Chart symbol [C], Line Framing symbol (L], and the
right edge for the symbol that shows the cursor’s position. The solid box
at the right edge of the window indicates the cursor’s line position.

Other symbols appear in the text to remind you of the format functions
that you used, but these symbols do not print. Symbols can be turned on
or off. For more information, see Function Mark ON/OFF on page 65.

A word processing file cannot exceed approximately 70,000 characters

(70 kb). To find out how much space you have remaining in the file, press
MENU. A box showing the remaining memory available for the file
appears. If the file becomes full while typing, you get this message:
“Memory full! Press any key to continue.” This means that the internal
memory is full, and you need to save this file on a diskette and open a
new file before you can continue writing your document.

Before saving the file on a diskette, press BACKSPACE or DELETE to
erase the last characters typed to make some memory available. You
should repeatedly press BACKSPACE or DELETE until you no longer get
the Memory Full message. Then you can save the file and open a new file
to continue writing your document.
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Using Basic Typing Features

Tty creating a short, simple
document and save it on a
diskette. For information on
saving a file, see Saving a Fife on
page 35.

You may also try lo print your
document. For information about
printing, see To print a document
on page 66.

Word Wrap

Hyphen

After the text is typed and the
document formatted, you can use
Hyphen Scan to insert soft
hyphens automatically. For
information, see To scan for
hyphens on page 41.

You cannot enter a soft hyphen at
the end of a line of text.

Types of Spaces

Type your text just as you would on a typewriter. The text appears in the
window instead of being printed on paper.

If you make a mistake, press BACKSPACE or DELETE to erase the
mistake.

Word wrap allows you to type sentences in a paragraph continuously
without entering a paragraph break symbol k<. When a word is going to
extend beyond the right margin, the word moves to the next line
automatically.

Normal hyphen. Typing a hyphen “-” in a word entered at the right
margin automatically sends the characters after the hyphen to the next
line. If the document is edited and the hyphenated word fits on the line,
the hyphen does not disappear.

Permanent hyphen. Use permanent hyphens for words that always
require 2 hyphen (e.g., mother-in-law). Permanent hyphens are entered
by pressing CODE + [-] and appear as [H]. If a permanent hyphen is used
in a word, it is treated as a normal character.

Soft hyphen. If word wrap moves a long word to the next line and you
want to hyphenate that word, insert a soft hyphen by pressing CODE + S.
The soft hyphen shows in the window as a dotted hyphen {-+<}. The part
of the word before the soft hyphen returns to the end of the previous line
if it can fit. If the document is reformatted so that the entire word can fit
on the same line, the soft hyphen disappears. If you think your document
may change, use a soft hyphen.

Soft spaces. Enter soft spaces by pressing the SPACEBAR. Soft spaces
separate words the same as pressing the spacebar on a typewriter. When
your sentence reaches the right margin, word wrap moves all of the words
that come after the last soft space to the next line. In Justify mode, the soft
spaces are adjusted to produce an even right margin. (See To justify text

on page 38.)
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Paragraph Break

Page Break

Permanent spaces. Enter permanent spaces by pressing CODE +
SPACEBAR. They are word separators that link words together. Permanent
spaces protect words from being separated on different lines. A
permanent space appears as the symbol [§f] and is considered part of the
two words it links. If two words separated with a permanent space are
entered at the right margin, they automatically move together to the
beginning of the next line.

At the end of each line of text, Word Processing automatically moves the
cursor to the beginning of the next line. This type of return is called a
soft return.

To mark the end of a paragraph, press RETURN. The cursor jumps to the
next line. A Return symbol g, called a hard return, appears in the text.

The Desktop Publisher automatically divides text into pages according to
your specifications. The place of these automatic page breaks is flexible
and readjusted for you by the Desktop Publisher if you change the text. In
the window, a page break appears as a horizontal line with a page
number.

You can also force the Desktop Publisher to start a new page at any point
by pressing CODE + P BREAK. This inserts a Page Break symbol [¥/] in the
text and creates a new page with the cursor positioned at the beginning of
the first line on the new page.

Tab and Paragraph Indent

For information about paragraph
indent, see Using a tab fto create
a paragraph indent on page 47.

Tab. When you press TAB, the cursor moves to the next tab and a Tab
symbol — appears. There are different types of tabs. For information on
setting tabs and using them, see To change margins and tabs on page 45.

Paragraph indent. When you press CODE + P IND the cursor moves to
the next tab and a Paragraph Indent symbol &3 appears. That place
becomes a temporary left margin. The cursor automatically returns to that
place, and the entire paragraph is indented until you press RETURN to
mark the end of the paragraph.

Typing Different Characters

Special characters on the keyboard. Most letter keys on the keyboard
can be combined with CODE to start operations. A few keys, however, are
available to type special characters. These keys have the characters printed
in green on the key (example: < on the Z key). To type such a character,
press CODE + the character key.
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For a complete list of extra
characters and symbols, see the
Extra Character Table in the

Appendix.

Symbols. Press CODE + SYMBOL to see the Symbol dialog box:

<< SYMBCL >

n-!-VO*ﬂ-.OIDOGAA"V

Press «, -+, 1, ¢ to select a letter and press RETURN. _

Use the arrow keys to select a symbol; press RETURN to put the symbol in
the text. '

Extra characters. Press CODE + E CHAR to see the Extra Character dialog
box:

<< EXTRA CHARACTER >

01 2 3 45 6 7 8 9 2 3 1/ 1

Press ¢, 2, 1, 4 to selecl a lelter and press RETURN.
Use the arrow keys to select an extra character; press RETURN to put the
character in your text.

In addition to the arrow keys, the following keys also move the cursor
quickly through the Symbol and Extra Character dialog boxes:

Keys Cursor Movement
[CODE + « To the beginning of the line

CODE + —» To the end of the line

CODE + T To the beginning of the previous line
CODE + ! To the beginning of the next line
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Using Basic Editing Features

Moving the Cursor Using Arrow Keys

EXPR RELOG

When you spot a mistaks in the
fine you are typing, move the
cursor back to the mistake,
correct the mistake; then press
CODE +— to return to your
previous lyping position.

Besides these methods for
moving the cursor, you can also
use the Search function to Jocate
a specific word, phrass, or title in
your document. For more
information, see To search for
text oh page 38.

To change text, you must first know how to move the cursor in the
document.

Moving one space at a time. The arrow keys T, |, «, and — move the
text cursor one space in the direction of the arrow.

Moving left and right. CODE+ < moves the cursor to the left rﬁargin.
CODE + — moves the cursor to the end of the line.

Moving one paragraph. SHIFT + « or SHIFT + - moves the cursor to
the next return, page break, or Column End symbol in the direction of the
arrow on the arrow key.

Searching for a Format symbol. SHIFT + T or SHIFT + | moves the
cursor to the left margin where the Format symbol appears.

Moving one window at a time. CODE + PRE S moves the cursor back to
the previous window, and CODE + NEXT S moves it forward to the next
window.

Moving to a specified page. CODE + GO TO moves the cursor to the
beginning of any page in the document. Affer pressing these keys, a dialog
box appears:

GO TO PAGE:

Type the page number; press RETURN. The cursor moves io that

page.
Instead of typing a page number, you can also press an arrow key.
The dialog box disappears, and the cursor moves as indicated in the

following table:

Arrow Key Cursor Movement
CODE+G + Tﬁ To the beginning of the current or previous page
CODE+G+4 To the beginning of the next page
CODE +G + To the beginning of the document
CODE+G+— To the end of the document
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Search Color Function

CODE + PRE S and CODE +
NEXT S are available for the
Search Color function only in the
GO TO mode.

The Search Color function can
search for the color of characters.

The Color Mark ONOFF option
allows you to recognize the
colored characters. For
information about Color Mark
ON/OFF, see page 65,

If you cannot locate a color, the
machine beeps, and the following
message appsars:

“Other color(s} not founa.”

Inserting Text

To use the Search Color function, press CODE + GO TO to open the Go To
dialog box; then press CODE + T or CODE + | to search for the color of
characters in the document.

* CODE + T moves the cursor to the first character of a color block.

If the cursor is located in the middle of a color block, pressing CODE + T
moves the cursor to the first character of the same color block.

Example: The sequence of characters, 1234567890, is
divided into two colors, where 123 4 S are red and 6 7 8 9 0 are
blue. If the cursor is located at 9, pressing CODE + T moves the
cursor to 6 (the first character in the blue color block).

If the cursor is located at the first character of a color block, pressing
CODE + T moves the cursor to the first character of a previous color
block.

Example: In the same color sequence as in the above example,
but now with the cursor located at 6 (first blue character), pressing
CODE + T moves the cursor to 1 (the first character in the red
color block).

* CODE + T searches from the cursor location to the top of the page. If
the cursor is already at the top, it searches to the top of the previous
page.

* CODE + NEXT S moves the cursor to the first character of the next color
block.

Example: If the sequence of characters, 1234567890, is
divided into two colors, where 1 23 45 areredand 6 78 9 0 are
blue and the cursor is located at 1, pressing CODE + { moves the
cursor to 6 (first blue character).

e CODE + | searches from the cursor location to the top of the next page.

You can add text in the middle of 2 document either in Insert or in
Overwrite mode.

Insert mode. The characters you type are inserted at the cursor, and the
rest of the line moves to the right automatically.

Overwrite mode. As you type, your new information replaces the
existing text.

To change between the Insert and Overwrite modes, press INSERT. The
indicator on the status line changes accordingly to B or ¥,
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Deleting Text

Deleting a character. Press BACKSPACE to delete one character to the
left of the cursor. Press DELETE to delete the character at the cursor
position,

peleﬁng a word. To delete a word, position the cursor on the space
immediately following the word and press WORD OUT.

Deleting a line. To delete a line, position the cursor anywhere after the
last character of the line and press CODE + LINE OUT.

Itis not possible to delete a Deleting a block of text. You can delete any amount of text by using

Retum symbol g if the two Block/Del . .
paragraphs have different ock/Delete. For more information, see To delete a block of text on page

formats. 52.

Using the File Menu

N Edt  suyie Use the File menu to open, save, close, delete, or rename your files;

. initialize disks; and return to the Main Menu. Use T and 4 to see the
Qeen Fife : complete function menus.
TN Edt  swie * Create New File. Opens a new file in the program that is currently

selected.

* Open File. Saves the current file to diskette and opens another.

IHH Edit Style

File Management

Save File. Saves the current file to diskette without closing it.

Close File. Saves the file and returns to the Main Menu.

File Management. Opens the File Management window.

Tips for Using Files

CAUTION:
Do not remove a diskette while the Desktop Publisher is saving a

document to the diskette or while the Desktop Publisher is reading
a document from the diskette. It could permanently damage the
diskette or cause you to lose information.

* To save the current file, use Save File or Close File.

* You can organize your files in File Management; however, File Copy,
Disk Copy, List Print, and Convert are not available. For information,
see File Management on page 85.

pTo create a new file:

Create New File opens a new file 1. Press MENU to see the menu bar; select Create New File from the
in the program currently selected. File menu. If the current file has not been saved onto the diskette,

your Desktop Publisher asks if you want to save it.
2. Select YES, NO, or CANCEL. Press RETURN.
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* YES. Shows the Save File dialog box. For information, see Saving a
File on page 35.

* NO. Closes the current file without saving that file.
* CANCEL. Cancels the function and returns to the previous screen.
pTo open a file:

1. Press MENU to see the menu bar; select Open File from the File
menu. If the current file has not been saved onto the diskette, your
Desktop Publisher asks if you want to save it.

2. Select YES, NO, or CANCEL. Press RETURN.

* YES. Shows the Save File dialog box. For information, see Saving a
File on page 35.

® NO. Closes the current file without saving that file.

Open File opens a Word
Processing, or Addressbook file.

* CANCEL. Cancels the function and returns to the previous screen.
Save and close or just close the file, and the list of files appears:

_J rd Protessing Addressbook 1S

SNEWTE =T

Select g file and press RETLIRM. Fress CANCEL o select mode.

The file list can show two indexes: Word Processing and Addressbook.
The list of files for the program you are currently using appears before the
other indexes with its title bighlighted, and this message appears:

lSelect mode and press 4 to select a file. l

3. To select, press ¢ or — to highlight a title; then press L. The cursor
moves inside the file list and bighlights the file name in the upper left
corner. This file name is either X NEWTEXT, or >kNEWBOOK, each

You can remove a diskette and allowing you to start a new file. This message appears:
insert another one when the list of

files appears. The screen Select a file and press RETURN. Press CANCEL to select
automatically updates to show the mode .

directory of the new diskette.
i 4. Press the arrow keys «, —, T, {, CODE + T, or CODE + | to select a

file. Then press RETURN to open the file.
OR
Press CANCEL to move the cursor back to the title of the list.

pTo save the current file without closing:

If you get a message indicating you 1. Press MENU to see the menu bar; select Save File from the File
have an unformatted or damaged menu. The Save File dialog box appears, with the file name given at
diskette, replace it with another, or \ . ) .

go to page 16 in Getting Started for the top. For more information, see Saving a File on the next page.
information on how to initialize a 2. Press RETURN. The file is saved to diskelte.

diskette.
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Close File

Saving a File

If you get a message indicating
You have an unformatted or
damaged disk, replace the
diskelte with another or go to
page 16 in Getting Started for
instructions on how to initialize a
diskette.

File name conventions

Close File allows you to return to the Main Menu after saving the file.

Press MENU to see the menu bar; select Close File from the File menu,
This dialog box appears:

Save currant file befare closing? ]

Use cursor to select and press RETURDM.
i =

B (NO] [CANCEL]

* If you select YES, the Save File dialog box appears. See Saving a
File below.

Type in the file name and press RETURN. The current file is
saved and the Main Menu appears.

* If you select NO, the current file is deleted and the Main Menu
appears.

* If you select CANCEL, you return to the current file.

When Create New File, Open File, Close File, or Save File is selected from
the File menu, the Save File dialog box appears.

<< SAVE FILE >= FILENAME: JWPT
Existing File(s) §

Type filensme and press RETURM. Fress 1, 4 to scrall file directary.

If you try to open another file using Create New File or Open File,
Desktop Publisher asks if you want to save your current file. If you select
YES, the Save File dialog box appears.

» If you have been working on a new file, the file name is empty and
you must type a file name. (Sce File name conventions below.)

* If your file has already been saved on the diskette, its file name
appears.

You can press RETURN to save the file with changes.
OR

You can also type a new file name to keep both the original and
modified versions in separate files.

* The correct file name extension appears in the file name entry field
(such as WPT for Word Processing and MRG for Addressbook), and a
list of the files from the same application appears.

* A file name consists of up to eight characters (a beep sounds if you try
to enter more). The file name is followed with a period and a
three-character extension that is automatically created by the system.
You cannot change the extension.
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* The Desktop Publisher accepts only the following characters in file
names: upper- and lower-case letters of the English alphabet (A-Z and
a-z), digits (0 to 9), and the hyphen (~). All others are refused and
cause the Desktop Publisher to beep.

* The Desktop Publisher does not distinguish between upper- and
lower-case letters. All letters are converted into capitals.

File Management

Press MENU to see the menu bar; select File Management from the File

menu. Press RETURN. Press MENU again to use the File menu to delete or
rename files.

* File Delete. Erases files from the diskette.
* Rename. Changes the name of a file.

¢ Exit. Exits from File Management back to your document.

Use the Disk menu to delete all files, initialize diskettes, and view diskette
contents.

* Delete All. Deletes all unprotected files on the diskette.

* Initialize Disk. Prepares the diskette to accept Word Processing files,
Addressbook files, etc.

* Directory Read. Reads the list of files on a diskette when this has not
been done automatically.

Press CANCEL as many times as needed to return to the Input/Edit screen.

For more information, see File Management on page 85.
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Using the Edit Menu

Use the Edit Menu to change the appearance of your text, to create

Bl sStie Biock headers and footers, or to set up merge codes that generate letters
automatically.
Right Margin Flush & * Centering. Centers text between the margins

* Right Margin Flush. Aligns text flush with the right margin

Bl Syle Block

Justify t

* Justify. Adjusts the space between words evenly so that the last
character of a line is aligned with the right margin

Style Block * Search. Searches the document for a specified string of characters

Replace L3

¢ Replace. Searches the document for a specified string of characters and
replaces it with another string

Style Block ¢ Header. Defines a block of text at the top of a page

* Footer. Defines a block of text at the bottom of a page

Hyphen Scan ¥

* Hyphen Scan. Scans the text for unhyphenated words that can be
divided

¢ Merge Code. Inserts merge codes that will be replaced automatically
with information from an Addressbook file during printing

m Style Block

‘H_-,gphen Scan ‘rI
pTo center text:

The Centering function centers a 1. With the cursor on the line to be centered, press CODE +F. A
line of text between the margins. centering symbol [0] appears. The cursor moves o the center of the line.

You can use it to center the text )
being typed or that has already 2. Type the text; then press RETURN. The text is centered.

been typed.

Use one of the following methods to undo centering:

* Delete the Centering symbol [O].

» Press CODE + F a second time.

s Press CANCEL.

e Select Centering from the Edit menu a second time.

P To align text Right Margin Flush:

Right Margin Flush aligns text 1. With the cursor on the line to be aligned, press CODE + R. A Right

flush with the right margin. You Margin Flush symbol 3| appears. The cursor moves to the right

can use it to align the text being margin.

typed or the text that has already

been typed and formatted. 2. Type the text; then press RETURN. The text is aligned with the right
margin.

Use one of the following methods to undo the margin formatting:

e Delete the Right Margin Flush symbol §].

* Press CODE + R a second time.,

* Press CANCEL.
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* Select Right Margin Flush from the Edit menu a second time.

P To justify text:
s‘::ccei"biftﬁf:; ,:hvio":;i”; ;’; :;?"‘f 1. With the cursor on the paragraph to be justified, press CODE + J.
the fast character of each fine s The AUTO indicator on the status line changes to JUST.
exactly on the right margin. 2. To cancel the Justify mode and resume normal typing or to undo
Any line that ends in a [&-] justified text, go to step 1. The JUST highlighting changes to AUTO.
symbol cannot be justified. When you switch the Justify mode on (or off), a Format Change symbol
[ E] appears in the dead column at the beginning of the paragraph. The
Justify mode remains on (or off) from that point to the end of the
document or up to the next Format Change symbol.
pTo search for text:
The Search function allows you to 1. Press MENU to see the me bar: i
i s press MENU [0 sce the r nu -ar, select Search from the Edit menu.
characters, Addressbook uses g ppears:
this function in a similar way.
%< SEARCH 5> [OVERFEHLIME

SEARCH:

START POSITION: CURRENT SEARCH: WHOLE WOQRD CHECK OFF
CASE CHECK OFF

Type SEARCH word{s) and press RETURM.

2. Type the string to be searched (40 characters maximum).
3. Press «, —, T, and d to move the cursor to a setting. Press
SPACEBAR to select other settings.
* START POSITION:
CURRENT—Scans the text from the current cursor position.
TOP OF FILE—Scans the text from the beginning of the file.
» SEARCH: WHOLE WORD CHECK

OFF—Stops scanning if the string is found even inside a word.
(For example, “the” will be found in “these”).

ON—Stops scanning only when the string is 2 word by itself.

¢ SEARCH: CASE CHECK
OFF—Turns off the system’s ability to distinguish between
upper- and lower-case letters. (For example, if the string is
“the,” the system stops at “tHe,” “THE,” etc.)

ON—Stops only at strings in exactly the same case.
4. Press RETURN when you have made your selections. The Desktop

Publisher starts searching. If an occurrence of the string is found, it is
bighlighted and a dialog box appears:

Continue search?
Use cursor to select and press RETURM.
L]

INO] [CANCE

5. Select YES or press TAB to start searching again, or select NO to
stop. The cursor is positioned on the last searched word if NO is
selected. Select CANCEL to end the operation. The cursor returns to
the original position. When the string cannot be found, this message

appears:
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@rd(s) not found. AI

p-To replace text:
:he ,qep;a?e function searches L. Press MENU to see the menu bar; select Replace from the Edit menu
or a specified string of The Replace dialo : ’
characters and replaces that i g box appears:
SEARCH. <% REFLACE »» Mml

string with another string.
REPLACE: COBEERT oo
START FOSITION: CURRENT SEARCH: WHOLE W
REPLACEMENT MODE: MaNUAL ) CASE gHEgl?D CHEDK g;E
Twpe SEARCH & REFLACE wordis) and press RETURM

2. Press <, —, T, and { to move the cursor to a setting.

3. Type the search and replace strings (40 characters maximum). Press
the SPACEBAR to select other settings.
* START POSITION:
CURRENT—Scans text from the current cursor position.

TOP OF FILE—Scans text from the beginning of the file.

* REPLACEMENT MODE: ,
MANUAL—Sets the system to ask whether or not to replace
each time a string is found.

AUTO—Replaces all occurrences of the string automatically.

* SEARCH: WHOLE WORD CHECK
OFF—Stops scanning if the string is found, even inside a word.
(For example, “the” will be found in “these”).
ON—Stops scanning only when the string is 2 word by itself.

* SEARCH: CASE CHECK
OFF—Turns off the system’s ability to distinguish between
upper- and lower-case letters. (For example, if the string is
“the,” the system stops at “tHe,” “THE,” etc.)
ON—-Stops only at strings in exactly the same case.
4. Press RETURN when you finish. The Desktop Publisher starts
searching. In AUTO mode, this message appears after all replacements
are made:

ICompleted. l

In MANUAL mode, when an occurrence of the string is found, it
appears inversely, and a dialog box appears:

Raplaca?

Use cursor to select and press RETURRM.

v E = =] [CAMNCEL]

5. Select YES to replace that occurrence and start searching again.
Select NO or press TAB to start searching again without replacing.
Select CANCEL to end the operation. The cursor returns to the
original position. When the string cannot be found, this message

appears:
[Word{s) not found. j
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The Headet/Footer functions print
a line of text at the top (header)
or bottom (footer) of each page of
the document,

p>To put in headers and footers:

1. Press MENU to see the menu bar; select Header or Footer from the
Edit menu. The Header or Footer dialog box appears:

| << HEADER »>

ﬁo....a."..‘ﬁ:...:

| << FOOTER >>

ﬁﬂ....:....‘ﬂ‘....:...

if you print a header or footer in
36 point type, the page margin
cannot be less than 1.17 inches.
To change the header/footer
margin, see To set page size and
margins on page 50.

Before printing your document, do
not forget to select YES or NO for
header or footer at the Word
Processing Print Menu. For
information, see To pint a
document on page 66.

2. Type header and/or footer text to appear on every page. You can
use centering, right margin flush, attributes, font type and size, color,
margin settings, and tabulation without affecting the layout of the
document. However, text must fit on a single line.

3. When finished editing, press MENU to see the menu bar; select Exit
from the Edit menu.

Editing Headers and Footers

Bl sy
Right Margin Flush +
Style
FHeuder 1
Bl st

Auto Page Numbearing 1

To access Auto Page Numbering
from the Edit menu, you must be
in the Header or Footer screen.

You can number pages in your
document automatically.

Use the following functions from the Edit menu to make changes to the
appearance of header/footer text:

* Centering. Centers header/footer between the margins
* Right Margin Flush. Aligns header/footer flush with the right margin
» Header. Opens the Header mode during the Footer mode

Footer. Opens the Footer mode during the Header mode

[ ]

¢ Auto Page Numbering. Numbers pages in your document

Exit. Exits from the Header or Footer mode to the document File
menu

For information on Centering, Right Margin Flush, and Header/Footer, see
page 37.

pTo put in Auto Page Numbering:

1. Press MENU to see the menu bar; select Auto Page Numbering from
the Edit menu. This dialog box appears:

START NUMBERING WITH PAGE NUMBER:

Type number and press RETURN.

2. Type the number of the first page. Press RETURN. The number
appears between double quotation marks.
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Style Menu
=1 I

Tnpe Stule Change

Font % Size

—

5.

fdarging & Tabs

A hyphen inserted with Hyphen
Scan is treated as a soft hyphen.
When reformatting, if a word
containing a soft hyphen fits
within the margins, the soft
hyphen is deleted.

OR

Automatically number pages in your document by including a
number between double quotation marks. For example, if your

header or footer is Page “1,” the first printed page shows Page 1, the
second shows Page 2, and so on.

Use the Style menu to change the appearance of your header or footer
text.

* Type Style Change. Switches attributes on or off

* Font & Size. Select font type, size, and mode

* Color. Selects color of characters and attributes

* Margins & Tabs. Set left and right margins and tabs

When the text cannot fit on a single line, a dialog box appears:

Data will be truncated!
OK to change margins?

Use cursor to select and press RETURN.

[V ES] INO]

Select YES or NO; then press RETURN.
* YES. Changes the margin and truncates (cuts off) text that exceeds
the right margin
* NO. Does not change the margin

Since word wrap automatically transfers a word that cannot fit in the
current line to the next line, excessively long blank spaces may appear in
your document resulting in a poor layout.

Hyphen Scan automatically detects such long blank spaces and gives you a
chance to hyphenate long words. It allows you to type your text without
inserting any hyphens manually (except permanent hyphens).

pTo scan for hyphens:

1. Press MENU to see the menu bar; select Hyphen Scan from the Edit
menu. The Hyphen Scan dialog box appears:

<< HYPHEN SCAN >>

HYPHENATICN HOT-ZONE: 5]
[2 (0.2INCH) ~ 9 (0.9INCH]]

START POSITION: CURRENT

Type number and press RETURN.

2. Press T and { to move the cursor to a setting.

3. Type the number for the hot-zone width (2-9). Press the SPACEBAR
to select the start position setting.

* HYPHENATION HOT-ZONE:
2 through 9—Defines the width of the hot-zone.
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Use the Merge Code function to
send a similar lelter to numerous
addresses, with each lefter
having a different name and
address but the same contents.
This function prints the same
letter continuously, while
automatically inserting changing
information (such as names and
addresses) into the document at
the same position.

* START POSITION:
CURRENT—Scans text from the current cursor position.
TOP OF FILE—Scans text from the beginning of the file.

4. Press RETURN when you finish. The Desktop Publisher starts scanning

the document. If a word leaves a blank space that is wider than the
specified Hyphenation Hot-Zone, the Hyphenation dialog box appears:

OK to hyphenate?

| fal-ling ]

Us&_-::ur-s-:-r to select and press RETURM. Prezs SFACE to change hvphen position
[NQ] [CANCEL]

5. The dialog box shows a possible hyphen position for a long word.

Press <~ and — to select the following items; then press RETURN.
(You can also press TAB instead of selecting NO.)

* YES. Hyphenates the word as shown and resumes scanning.
* NO or TAB. Resumes scanning without hyphenating that word.

* CANCEL. Cancels the function and returns to the original cursor
position.

6. To change the hyphen position, press the SPACEBAR while showing

the Hyphenation dialog box. The hyphen position changes within the
range of possible bypben positions.

pTo merge text from two documents:
1. Create a file containing the information to be inserted in the letters

(the Addressbook file). For information, see Addressbook on page
71. The information to be inserted in a single letter is called a
record. A record is made of labels that correspond to different
pieces of information needed to insert in a single letter (Name,
Address, etc.). Organize your Addressbook file logically, with the
same label in each record containing the same type of information.
Addressbook allows you to mark records for merge printing.

. Create 2 Word Processing file containing the text that is common to

all the letters (the master document). Wherever variable information
is to be inserted in that text, insert a Merge symbol using the Merge
function described in this section.

. Print the Master Document. The text prints as usual until a Merge

symbol is encountered. At that point, the program compares the
label name that you have inserted with the merge symbol and
automatically replaces the Merge symbol with the information
contained in the corresponding label of the first marked record.

When the whole document prints, the Desktop Publisher checks the
Addressbook file to see if there are more marked records. If there
are no more records, merge printing is completed. Otherwise
printing of the Master Document starts again using the next marked
record of the Addressbook file. The process repeats until all records
of the Addressbook file have been used.
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p-To insert merge symbols in your document:

1. Position the cursor in the text where the merged information
belongs.

2. Press CODE + M. The Merge Code dialog box appears:

<< MERGE CODE »>

LABEL NAME:

Type label name and press RETURN.

3. Type the name of the label (12 characters maximum) corresponding
to the Addressbook information you want inserted at this point.
Press RETURN. The label name is entered as it appears in the
Addlressbook.

4. Type Last Name, First Name, or one of the other label names at the
Merge Code dialog box. The label name, surrounded by merge
symbols [M], appears in the text. ’

5. If necessary, set the font type, size, and color as well as the attributes
for the label name. During merge printing, the merged information
uses those settings.

6. After inserting all merge symbols, you can start merge printing. For
information, see To print a2 document on page 66.
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Using the Style Menu

m Block  Graphics

Twpe Shile Thange

Font 8 Size +

]Co!o; 1"
lLine Spacing ‘I‘I
Copy Format 1|
]Qe#ete Format 1|

Margins & Tabs, Line Spacing,
and Multi-Column are applied
from the paragraph the cursor is
on to the end of the document, or
to the next Format Change
symbol.

Page Setup applies to the entire
document.

To change the lype style of
previously fyped texi, use the
Block Menu on the menu bar. For
details, see Using the Block
menu on page 51.

Undetriine is an exception to the
tule in step 2. Pressing the
SPACEBAR once tums
Continuous Underline on.
Pressing it again tums Word
Underiine on, and pressing it
ohce more turns underiine off.
With Continuous Underfine,
everything is underlined. With
Word Underline, spaces between
words are not underlined.

Use the Style Menu to change the appearance of your document:
* Type Style Change. Switches attributes on or off

* Font & Size. Selects font type, size, and mode
* Color. Selects color of characters and attributes
* Margins & Tabs. Sets left and right margins and tabs

* Line Spacing. Sets the line spacing

* Multi-Column. Switches the multi-column layout on or off and sets
the column width, number of columns, and column spacing

* Copy Format. Copies a Format Change symbol for pasting into the
text to change the format from that point

* Delete Format. Deletes a Format Change symbol

* Page Setup. Selects paper size and orientation and sets top and bottom
margins as well as the space for the header and footer

P To change type style:
1. Press CODE + T STYLE. The Type Style Change dialog box appears:

O SUPERSCRIPT
0O SUBSCRIPT
O 3SHADING

2. Press the arrow keys to move the cursor to the attribute setting, and
press the SPACEBAR to turn the attribute on or off.

3. Press RETURN when you finish.
You can apply more than one attribute at the same time. There are,
however, a few exceptions:

* NORMAL. Automatically resets all other attributes to off

* The following attributes cannot be set together; the last setting
overwrites the previous one:

OUTLINE, BOLD, and SHADOW

UNDERLINE and SHADOW

SUPERSCRIPT and SUBSCRIPT
Use the following short-cut keys to change attributes without showing the
Type Style Change dialog box:

CODE + B turns bold on or off.

CODE + T underlines continuously, underlines each word, or
turns off underline.
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use the Block mend on the monu CODE + FONT to open the Font & Size dialog box from the current Type

bar. For details, see Using the Style Change dialog box. If you want to change the color of the character,

Block Menu on page 51. press CODE + COLOR to open the Color dialog box directly from the
current Type Style Change dialog box.

p-To change font & size:

To change font & size, press 1. Press CODE + FONT. The Font & Size dialog box appears for all models

CODE + FONT to open the Font il .
& Size dialog box. similiar to the one below:

You cannot select Double Width At ABC abo 123
or Double Height when the font MODE: ~ NORMAL , > °
size is 24 or 36, because the e T shange seling an

resudting fonts would exceed the

capability of your Desktop

Publisher. If you try to do so, the 2. Press T.and d tc? move to the other item. Press SPACEBAR to change
font defaults to 18 NORMAL. the setting. While setting font and font size, you immediately see an

example of the effect of your settings in the box.
To change type style, press .
CODE + T STYLE to open the 3. Press RETURN when finished.

Type Style Change box.

p>To add color:
To change the color of previously 1. Press CODE + COLOR. The Color dialog box appears:
typed text, use the Block Menu
on the menu bar. For details, see << COLOR =2 _
Using the Block menu on page g;‘;‘;iﬁ;‘éﬁ
51. ‘ress SPACE fo change setting and press RETURRM.

On!y the foﬂowing three attributes ‘res STY 0 OMNT o open respective menu.
can be colored: Underline,
Strikeout, Shading.

2. Use the T and {4 to move to other item. Press SPACEBAR to select a
color setting.

3. Press RETURN.

B To change margins and tabs:

To change the margins of the 1. Place the cursor on the line where the new format is to begin.

nning of .
?he: ;i,i(} f;’;’f:,f,‘,’,’a';‘j 'S’Zf’;’;”,ifj,f 2. Press MENU to see the menu bar; select Margins & Tabs from the
the Style menu and press Style menu. This screen appears:
RETURN without changfng the C (L eft a jht} 4 (Tab) F (Center) 4 {Decimal) "4 (Leader) Default Margin
paper size. (AP SR S - U IS NP S DR S R
To reset the other formats, press Flove arrow and haracter key to set.
M io resst to the default margin Fress DELETE lo olzar tab.
setting in the Margins & Tabs
screen.
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3. Move the cursor to any position using these keys:

Key

if any of the keys in this table are &

pressed to set tabs or margins at -

a position where a tab or margin

has already been set, a [E ] code CODE + «

appears and the text is

ref fted.

slomatted CODE +-»
SHIFT + «
SHIFT + >
TAB

Function

Moves the cursor 1/10 inch to the left.
Moves the cursor 1/10 inch to the right.

Moves the cursor to the left margin or to 2/10 inch to the right if
the cursor was on the left margin.

Moves the cursor to the right margin or to the right end if the
cursor was on the right margin.

Moves the cursor 1/100 inch to the left.
Moves the cursor 1/100 inch to the right.

Moves the cursor to the next tab or to the right margin if there
are no other tabs.

4. To set margins and tabs, use the following keys:

Key

somo - 33 rr

DELETE
CODE +D

Margin/Tab Settings and Symbols

Sets the left margin at the cursor [ [ ].

Sets the right margin at the cursor | ]].

Sets a normal tab at the cursor [{].

Sets a center tab at the cursor [T ].

Sets a leader tab at the cursor [ ].

Sets a decimal tab at the cursor [{].

Resets the left and right margins to the default setting.
Clears the tab at the cursor position.

Clears all tabs.

A Format Change symbol [E] appears at the beginning of the paragraph
where the new format begins. The text reformats from that point to the
end of the document or to the next Format Change symbol.

5. Press RETURN when you finish.

Using tabs to create a table

You can create a table while typing. Pressing TAB moves the cursor to the
next tab to the right and shows a Tab symbol [—f]. Now type your text.
The way the text aligns with the tab depends on the type of tab you have

selected.

* Normal tabs. The text you type is left aligned with the tab.

* Decimal tabs. These tabs normally align numbers in a column so that
decimal points are vertically aligned. You can also use a decimal tab to
align any text to the right. The number you type is right aligned with
the tab, and the number moves to the left as you type. When you type
the decimal point, it appears at the tab position, and any further digits

that you type appear to the right.
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* Center tabs. The text you type is automatically centered around the
tab.

* Leader tabs. When you press TAB, the next tab is a leader tab that
provides a string of periods that begin where you pressed TAB and

continue to the tab. If you type text from that point, it is left aligned
with the tab.

You can also insert Tab symbols in the already typed text to rearrange the
text into a table. You need to press INSERT to add text because you are
not in the Insert mode. Move the cursor just before the text you want to
align and press TAB. The text is aligned to the tab.

To undo a table format, delete the Tab symbols [—Al-

Using a tab to create a paragraph indent

Instead of pressing TAB to create a new tab, press CODE + P IND to create
a paragraph indent. The cursor moves to the next tab, and a Paragraph
Indent symbol [\ appears. The tab becomes a temporary left margin (the
text you type wraps to the tab position). When you press RETURN to
mark the end of the paragraph, the cursor returns to the true left margin.
See the example below:

e
7.3

create a paragraph indent, to create 2 paragraph indend, to create a paragraph indent, to create
¥a paragraph indent, bo create & paragraph indent, toAcreate 2 paragraph indent, to
L nasaarsnk ind ) rasba B 2. b oindark

POy

ﬁTo create a paragraph indent, to create a paragraph indent, to create a paragraph indent, to

Using a tab to create a line indent
To indent the first line of a paragraph, press TAB at the beginning of the
paragraph to move the first line to the first tab position.

O iveiarn s B on i tarteunrndoniaBdosactentsBaarstonsedieeataebone,
ibeginning of the paragraph.«

pTo adjust line spacing:
1. Place the cursor on the line where the new format is to begin.

2. Press MENU to see the menu bar; select Line Spacing from the Style
menu. Press RETURN. The Line Spacing dialog box appears:

<< LINE SPACING =>

LINE SPACING:

Press SPACE to change setling and press RETILURRM.

* LINE SPACING:

AUTO1—Sets the line spacing according to the size of the tallest
character on the line.
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The Multi-Column feature prints
your document in newspaper
style, with up to four columns of
equal width across the page.

The margins set for your
document must be small enough
to accommodate all of the
columns and the assigned space
between the columns. If the
margins are not smalf enough,
the prompt “Incorrect setting!”

appears.

If you set tabs before tuming on
the Mufti-Column mode, only
those tabs that are within the
width of the first column are used
and are applied to the next
column.

AUTO2—Sets the line spacing according to the tallest character
in a line, plus 1/12 inch.

AUTO3—Sets the line spacing according to the tallest character
in a line, plus 1/6 inch.

AUTO1 AUTOZ AUTOS3
12 points a RAa Aa

Aa Aa

Aa RAa

ha ha

36 points Aa Aa Aa

3. Choose a setting and press RETURN. A Format Change symbol [E]

appears at the beginning of the paragraph. The text reformats from
that point 1o the end of the document or up to the next Format
Change symbol.

P To type text using more than one column:
1. After typing your text, place the cursor where you want

multi-column to begin.

2. Press MENU to see the menu bar; select Multi-Column from the Style

menu. The Multi-Column dialog box appears:

<< MULTI-COLUMMN >>
MULTI-COLUMM:

Press SFPACE to change setting and press RETURN.

. Press SPACEBAR to change the setting; press RETURN when you

finish.,
* MULTI-COLUMN:
OFF—Creates a single column.

ON—Creates up to four columns. If ON is selected, the
Mudti-Column dialog box changes as follows:

<< MULTI-COLUMN =2

MULTH-COLUMN:
NUMBER OF COLUMNS [Z2~4]: 2
SPACE BET. COLUNMNS: g

[1 (0.1INCH)} ~ 9 (D.9HNCHM

Press SPACE to change setling and press AETURRNMN.

. Press T and { to move the cursor to a setting; type in the numbers.

Press RETURN when you finish.
* NUMBER OF COLUMNS: Sets the number of columns.
* SPACE BET. COLUMNS: Sets the space between columns.

. Press RETURN. A Format Change symbol [E] appears at the beginning

of the paragraph. The text reformats from that point to the end of the
document or up to the next Format Change symbol.

Word Processing 48



We recommend that you first type
your text using standard margins
and format into multi-columns for
editing and printing. Typing in the
Muiti-Column mode requires your
Desktop Publisher to perform
extensive reformatting with each
line you type.

If you select this function when
the Format Change symbol is at
the very beginning of the file, the
position of the left and right
margin is sef automatically and all
tabs are cleared.

P To type text in multi-column pages:
1. Set up the multi-column function as described above.

2. Type your text for the first column. When the cursor reaches the end
of the first column, it automatically moves to the top of the second
column. When the cursor reaches the end of the last column, it moves
10 the top of the first column on the next bage.

* To move to the next page before reaching the end of the current
page, insert a Page Break symbol [¥] by pressing CODE + P BREAK.

* To move to the next column before reaching the end of the current
one, insert a Column End symbol [L] by pressing CODE + RETURN,
If columns of the current page end with a Column End symbol, the
cursor moves to the area beneath the columns so that you can
continue typing on the current page.

* If you delete a block that contains the Format Change symbol [E]
for the Multi-Column mode, this mode is canceled, but the
Column End symbols remain in the text.

* If you want to move the cursor to the next column, press CODE +
¢~ or CODE + —. The cursor moves to the left column by
pressing CODE + ¢« when the cursor is on the left margin. The
cursor moves to the right column by pressing CODE + — when
the cursor is at the end of the current line.

> To copy and paste formats tagged with the Format Change
symbol [F):
1. Move the cursor to the line that has the Format Change symbol you
want to copy.
2. Press MENU to see the menu bar; select Copy Format from the Style
menu. The arrow cursor appears at the right of the Format Change
symbol, and this message appears:

Copy?

Use cursor to select and press RETURM.

[TEZ] [NO}

3. Select YES to copy or NO to cancel. If you select YES, this message
appeats:

|Move cursor to destination of copying and press RETURN. !

4. Move the cursor to the destination and press RETURN.

pTo delete formats tagged with the Format Change symbol
[El-
1. Move the cursor'to the line that has the Format Change symbol you
want to delete.
2. Press MENU to see the menu bar; select Delete Format from the Style
menu. The arrow cursor appears at the right of the Format Change
symbol and this message appears:
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Delete?
L.!EE cursor to select and press RETURNM.

(EZ] INOI

3. Select YES to delete or NO to cancel the function.

P To set page size and margins:

1. Press MENU to see the menu bar; select Page Setup from the Style
menu. 7he Page Setup dialog box appears:

PAPER SIZE: T
TOP MARGIN: 1.09 PAPER LENGTH: 11.00 (A
BOTTOM MARGIN: 1.00 FAPER WIDTH: 8.50

TEXT LENGTH: 8.00¢

2. Move the cursor to Paper Size options. Press SPACEBAR to select.

3. Move the arrow keys to a position and type in a value in inches.

4. Press RETURN to return to the Input/Edit screen and confirm your
settings.

¢ If the paper size is set to LETTER, LETTER LANDSCAPE, A4, A4
LANDSCAPE, or A5, and the margin at the top of the text or
header/footer is not a default, this message appears:

QK te set rmargin size autormatically?
Use curser to zelact and press RETLRM.

YES. Automatically changes the margin settings and returns to
the Input/Edit screen.

NO. Returns to the Input/Edit screen without changing margin
settings.

e If the paper size is set to LETTER PORTRAIT and NO is selected,
or if more than 8.3 inch paper width is set in the OTHER option,
this message appears:

Chech margin settings!
Left margin must be more than 0.2inch.
Right margin must be less than 8.3inch.
Press any kay to continue.

If the paper is set to either LETTER LANDSCAPE or A4
LANDSCAPE and NO is selected, this message appears:

Check margin settings!
At least 0.Binch is nacessary for
baoth laft margin and right margin area.
Press any key to conlinue.

¢ If the text entered in the header or footer exceeds the range of the
margin due to the automatic margin change, the extra text is
deleted from the right end. Then, when the Header or Footer edit
screen appears, the prompt “Data bas been truncated.” appears.
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Using the Block Menu

PEM Goaphics Use the Block menu to change the location or appearance of a block of
text:

* Move. Moves a block of text to another location

Copy +

* Copy. Copies a block of text to another location. (The original location
is left unchanged.)

TypeShle Add T * Delete. Erases a block of text
Ml * Iype Style Change. Changes the attributes of a block of text

* Type Style Add. Adds the attributes of a block of text

Eont 8 Size 1
@I ¢ Font & Size. Changes the font, size, and proportions of a block of text

* Color Changes the color of a block of text

Tupsz Shile Change

P To move a block of text to a new location in the document:

If graphics are marked, format 1. Move the cursor to the beginning (or the end) of the block you want

change or line framing are ,
included in the marked block, and to move. Press CODE + E. This message appears:

that information moves together
with the text. Move cursor tc end of block to be moved and press RETURN.

To jump to paragraph end, press SHIFT + ¢, SHIFT + —.

2. Move the cursor to the end (or the beginning) of the block. If you
want to select paragraphs of text, press SHIFT + ¢« or SHIFT + —.
The cursor moves to the next return, page break, or Column End
symbol in the direction of the arrow key. As the cursor moves, the text
is highlighted.

3. Press RETURN when a block is marked. This message appears:

Move cursor to destination for blocked text and press RETURN.

4. Move the cursor to the destination for the block and press RETURN.
The block is removed from its original location and placed at the new
location.

pTo copy a block of text to a new location in the document:

1. Move the cursor to the beginning (or the end) of the block you want

If graphics are marked, format to copy. Press CODE + C. This message appears:

change or line framing are

included in the marked block, and -
that information is copied together ~|Move cursor to end of block to be copied and press RETURN.

with the text. To jump to paragraph end, press SHIFT + ¢, SHIFT + -3.

2. Move the cursor to the end (or the beginning) of the block. If you
want to select paragraphs of text, press SHIFT + < or SHIFT + —.
The cursor moves to the next return, page break, or Column End
symbol in the direction of the arrow key. As the cursor moves, the text
is bighlighted.

3. Press RETURN when the block is marked. This message appears:
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if graphics, format change, or line
framing are included in the
marked block, that information is
deleted together with the text.

These functions work the same
way as in the Style menu. Type
Style Add works the same as
Type Style Change. However,
using this function is the easiest
way to add attributes to a block of
text, because the current
attributes of the specified block of
text are already chosen when you
open the Type Style dialog box
from the Type Slyle Add feattire.

Move cursor to destination for blocked text and press RE-
TURN.

4. Move the cursor to where you want to place the block; press

RETURN. The block is copied to the new location without removing
the original text.

> To delete a block of text:

1. Move the cursor to the beginning (or the end) of the block you want
to delete.

2. Press CODE + D. This message appears:

Move cursor to end of block to be deleted and press RETURN.
To jump to paragraph end, press SHIFT + ¢«, SHIFT + —».

3. Move the cursor to the end (or the beginning) of the block. (If you
want to select paragraphs of text, press SHIFT + « or SHIFT + =)
The cursor moves to the next return, page break, or Column End
symbol in the direction of the arrow key. As the cursor moves, the text
is bighlighted.

4. Press RETURN when the block is marked. The system confirms with:

Deleta?

Use cursor to selecl and press RETURN.

INC)

¥

5. Select YES to delete the block or NO to cancel. Press RETURN.

pTo change type style, font & size, and color:

1. Press MENU to see the menu bar; select Type Style Change, Type
Style Add, Font & Size, or Color from the Block menu.

2. Select the text by moving the cursor to the end of the block where
you want to add or change attributes; press RETURN.

3. Press the arrow keys to move the cursor to a setting; press
SPACEBAR to switch the option; press RETURN.

The following are differences between these options and those in the Style
menu:

e You cannot use CODE + FONT, CODE + T STYLE, or CODE + COLOR to
start these functions in the Block menu. Pressing CODE + FONT when
the Type Style Change, Type Style Add, or Color dialog boxes appear
switches you to the Font & Size dialog box. Pressing CODE + T STYLE
switches you to the Type Style Change dialog box, and CODE +
COLOR switches you to the Color dialog box.

» The format change is applied to the selected block only.

* You can select the AS IS'setting for each item in the Font & Size and
Color dialog boxes to keep the setting as it is.
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Using the Graphics Menu

m Oplion
Edit Chart 4

mm Oplion

Line Framing
Capy Graphis

M Option

Copy Graphic

Delete Graphic

The Create New Chart function
allows you to create a new chart
and insert it in the document.
Three types of chart are
available: bar, fine, and stacked
bar.

if you try to insert a chart inside a
Multi-column format or where a
{C ] code or an | L] code already
exists, this message appears:

“Cannot insert at this position!
Mutti-column, chart, lineframing
or image data area. Press any
key to continue.”

You can go to the previous or the
next screen by pressing CODE +
+ orCODE+ |

Use the Graphics menu to create and edit charts and frames.
® Create New Chart. Creates a chart

» Edit Chart. Edits a chart

* Line Framing. Creates and edits a graphic frame
* Copy Graphic. Copies a chart or frame
¢ Delete Graphic. Deletes a chart or frame

pTo create a new chart:

1. Move the cursor tc a line below where you want to insert a chart.

2. Press MENU to see the menu bar; select Create New Chart from the
Graphics menu. The Chart Format dialog box appears:

<< CHART FORMAT =>
TYPE: FRAME: OFF
POSITION: LEFT SIZE: 2.0 X 3.0iNCH

Fress SPACE to change setting and press RETIIRR.

3. Press the cursor keys to move from one item to the next. Press

SPACEBAR to select an option. »

* TYPE: Select BAR, LINE, or STACKED BAR to create the kind of
chart you want.

¢ POSITION: Select LEFT, CENTER, or RIGHT to align the chart with
the left margin, to the center between margins, or with the right
margin.

* FRAME: Select OFF, THIN, or THICK to create no frame, a thin
frame, or a thick frame for your chart.

* SIZE: Choose 2.0 x 3.0 inch or 4.0 x 6.0 inch to select one of two
sizes for your charts.

* LINK LINE: Select OFF or ON to show increases and decreases of
each item in a Stacked Bar chart by adding lines from the
boundaries of items in one stack to equivalent ones in the next
stack. (Link Line can be selected only when Stacked Bar chart is
selected.)

4, Press RETURN when finished.

Creating a Bar, Line, or Stacked Bar chart

If you select Bar, Line, Stacked Bar, or 100% Stacked Bar, the Chart Title
dialog box appears:

<< CHART TITLE >>

TITLE:
X-AXIS TITLE:
¥-AXIS TITLE:

[Type litle and press RETURN.
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See Chart examples on page 54
for sample bar and line charts,

If you need to delete while
entering information, see Deleting
data on page 55.

* TITLE: The title of the chart (example: Employees). The maximum
length is 30 characters.

® X-AXIS TITLE: The title you want on the x-axis (horizontal axis).
The maximum length is 20 characters (example: Age).

* Y-AXIS TITLE: The title you want on the y-axis (vertical axis). The
maximum length is 20 characters,
P To create Bar, Line, or Stacked Bar charts:

1. Type the title for your bar or line chart and titles for the X/Y axis
and press RETURN. This Chart Data dialog box appears:

YIRS GUER]:HUM:
LEGEND [_:I

Twpe data and presz CODE + RETLURM.

* LEGEND. The label you want for each row of information
(example: female, male). You can enter a maximum of five labels.

¢ X-AXIS. The information you want to appear on the x-axis, which
appears under each bar or line (example: under 30, 30-50, S0+).
You can enter a maximum of 12 items. After entering each item,
press TAB to enter another item.

* Inside the grid (under LEGEND and X-AXIS). The numeric
information, which appears as bars of relative heights. You can
enter a2 maximum of 12 sets (columns) of five different values.
Each value can contain up to 15 digits, a decimal point, and a
minus sign.

2. After entering your information in the Chart Title and Chart Data
dialog boxes, press CODE + RETURN. 7This screen appears showing
the chart you created with the information you entered:

* If RETURN is pressed, the chart will be inserted into your
document. A chart symbol [C] appears in the dead column. The
title of the chart appears in your document. When you print, the
complete chart prints.

* Press CODE + T to return to the Chart Data dialog box.

* CANCEL. Cancels the function. This dialog box appears:

CK to delete all CHART DATA?

Use cursor to select and press RETURMN.

[VEZ] [NQ]

3. If you select YES, the Create New Chart function is canceled and
your information is lost. If you select NO, you return to the Chart
Format dialog box.

Chart examples: The following sample charts show the relative
proportion of employees of a company in three age brackets (under
30, 30-50, and 50+) and separately show the numbers of female and
male employees. Use the first row of the grid to show the number of
female employees (example: 32, 25, 30) and the second row to show
the number of male employees (example: 30, 28, 28).
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The sample bar chart contains
three clusters of two bars, one
cluster for each age bracket.

With a stacked bar, the two bars
of each cluster are stacked one

above the other,

Deleting data

Final points

Bar Stacked Bar

Employees Etnployees

Aqa Aqe

Mismaie Elmale Miwrmaiz Evai
Line
Emplaoyees
w
78 --.-,.E__;:_._.,.,_.e_-:ﬂ
2
10
under 80 $0-50 H
~femaie -y Aae

Press CODE + D while entering information to delete only the input
information. This dialog box appears:

OK to delete all input data?

Use cursor to select and press RETURN.
1Y ES] NG|

If you select YES, everything within the chart (the legend, x-axis item, and
all numeric information) is deleted, but the Chart Data dialog box remains
in the window. Select NO to return to the dialog box without deleting.

* The numeric information can consist of a2 maximum of 15 digits
(maximum 5 digits after the decimal point).

* Numeric values greater than 10,000 or smaller than 1 are shortened
using these symbols:

10,000 10K (thousand)
10,000,000 10M (million)
0.01 10m (milli)
0.00001 10p (micron)
* Negative values are set as zero,
p-To edit a chart:
1. Move the cursor to the line with a chart (symbol T) you want to

edit.
2. Press MENU to see the menu bar; select Edit Chart from the Graphics
menu. A screen simmilar lo the following appears:
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Press RETURN to edit.

If you press RETURN, the Chart Format dialog box appears. Proceed as
you would when creating a new chart.

P> To create lines and frames within your document:

1. Press MENU to see the menu bar; select Line Framing from the
Graphics menu. This screen appears: ‘

I €< PAAMING >> fova to start posilion & AETURN. SEACE far line.

ﬂ .......... E— ........................................................ 17-3-.i.. |

The cursor is replaced with the cursor symbol [<).

2. To draw a line, move the arrow to the start position for the line;
press RETURN. The previous message is replaced with:

Move to line end & RETURN to draw. DELETE to undo.

3. Press the arrow keys or TAB to move the cursor symbol [<] to the
end position for the line and press RETURN. (You can also press
DELETE to delete the line.)

Keys Cursor movement
%% e %
5/60 inch

4

— 10/100 inch

-

SHIFT + T 1/60 inch

SHIFT +

SHIFT + « 2/100 inch

SHIFT + —

CODE + 7 Moves the cursor to the next frame line, left margin, or right

CODE + | margin

CODE + «

CODE +—

TAB Moves to the next tab, right margin, right edge, or in
mutti-columns, next column

* After the start position is set and the cursor is moved, a [+] sign
appears at that position.

* Move the cursor horizontally for a horizontal line, vertically for a
vertical line, or horizontally then vertically to draw a box whose
diagonal is defined by the start and end points.

* If you press [ . ] while moving the cursor horizontally or vertically
in the mode to set the end point, a [+] sigh appears at the
position. When you set the end position, press RETURN and you
can draw any complex frame.
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* You can set frame line thickness by pressing the SPACEBAR to
alternate between “thin” or “thick”.

4. Repeat steps 2 and 3 to draw all the lines.

* To change the thickness of an existing line, redraw it with the new
thickness.

* A frame cannot contain more than 23 rows or 30 columns. The
sample table below has four columns and three rows:

If you try to exceed the limit, this dialog box appears:

Crossed positions full!
Press any key to continue.

5. When the frame is complete, press MENU to see the menu bar; select
Exit from the Operate menu to return to the Input/Edit screen. A
Frame symbol [L] appears in the dead column. This symbol contains
the format information as well as the frame information. If there
already is a Format Change symbol where the Frame symbol is to
appear, the Frame symbol replaces the Format Change symbol. You
see the Frame symbol at the beginning of the paragraph the cursor
was on when you started the Line Framing function.

Editing a frame
Use the Operate menu to color and edit frames.

Color. Selects the color of frames

Enlarge/Reduce. Enlarges or reduces frames

Delete All. Deletes all the lines in a frame

« Exit. Finishes the Line Framing mode

To edit an existing frame, place the cursor anywhere within the frame text
area. Select Line Framing and continue as you would in creating a new
frame.

If you place the cursor outside the frame area and start the Line Framing
function, the Desktop Publisher assumes that you want to create a new
frame.

pTo select the color of frames:

You cannot combine several 1. Press CODE + COLOR. The Color dialog box appears:
colors in the Line Framing mode.

If the frame exists in the file
before you set the color of the

<< COLOR »»

; CHARACTER:
frame, its color changes fo the ATTRIBUTE: SLACK

new color,

SP&CE to change setting and press AETIURM,
TYLE or FONT to open respective menu.
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2. Press SPACEBAR to change setting.
3. Press RETURN.

pTo enlarge or reduce a frame:

1. Move i i
This function is available only the clursor to the right bottom corner of the cell which you
when the cursor is located on the want to enlarge or rﬁduce.
edge of the cell. 2. Press MENU to see the menu bar; select Enlarge/Reduce from the
Operate menu. This message appears:

Cursor to adjust size & RETURN. CODE + T, |, «, — moves
cursor.

Use the following key combinations to enlarge or reduce frames:

Key Cursor Movement

— Reduces the frame 1/4¢ inch to the left

— Enlarges the frame /4 inch to the right

T Reduces the frame 1/, inch at the top

l« Enlarges the frame 174, inch at the bottom

SHIFT + « Reduces the frame /g inch to the left

SHIFT + — Enlarges the frame 1/gq inch to the right

SHIFT + T Reduces the frame /g inch at the top

SHIFT + | Enlarges the frame 1/gq inch at the bottom

CODE + « Maves the cursor to the next line without
changing the size

CODE + > Moves the cursor to the next line without
changing the size

CODE + T Moves the cursor to the next line without
changing the size

CODE + | Moves the cursor to the next line without
changing the size

3. Press RETURN when finished.

pTo delete all the lines of a frame:
Press CODE + D. This dialog box appears:

Delate?

Use cursor to select and press RETURM.

== [NC

Select YES to delete all of the frame information or NO to cancel. -

p-To exit the Line Framing mode:
Press CANCEL.

Word Processing 58



P> To copy a chart or frame to another location:

1. Move the cursor to the line with a Chart s

A ymbol [C] or Frame symbol
[L] to be copied.

2. Press MENU to see the menu bar; select Copy Graphic from the

Graphics menu. The arrow cursor appears next to the [C] or [L ]
symbol and this message appears:

Copy?

Use cursor to select and press RETURN.
[(VES] [NO]

3. Select YES to copy or NO to cancel the function, If YES is selected,
this message appears:

lMove cursor to destination of copying and press RETURN. j

4. Move the cursor to the new location and press RETURN.

pTo delete a chart or frame:

1. Move the cursor to the line with a Chart symbol [C] or Frame symbol
[L] to be deleted. ,
2. Press MENU to show the menu bar; choose Delete Graphic from the

Graphics menu. The arrow cursor appears next to the [C] or [L
symbol and this message appears:

Delete?
Use cursor to select and press RETWRMN.
[NO]

3. Select YES to delete the chart or line or NO to cancel.

If you select Delete Graphic or Copy Graphic when the cursor is not

located on the line with a Chart symbol [€] or Frame symbol [L ], this
message appears:

Formal mark does not exist at this position!
Press any key to continue.
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Using the Option Menu

mcgeen Print

Check during Teping ONIOFF 4
m Screen  Print

Type Thesaurus L

Spell Check All searches for
misspelled words or capitalization
errors from the beginning of the
file or from the current cursor
position; however, it does not
replace careful proofreading. It
has no way of knowing, for
example, whether words are
missing or whether a given word
is grammatically or syntactically
correct. If you type ‘teh” instead
of ‘the”, spell check alerts you,
but if you type “one” instead of
“on”, it does not consider it a
mistake.

Misspelied words

Use the Option menu to check spelling or maintain a user dictionary.
* Spell Check All. Checks spelling in a file
* Check during Typing ON/OFF. Checks spelling while typing

* User Dictionary Maintenance. Edits, loads, and saves a User
Dictionary file

* Iype Thesaurus. Lists synonyms (another word with the same
meaning) for a word

* Edit Thesaurus (below Type Thesaurus on menw). Lists synonyms for
the word at the cursor in a file

pTo check spelling in text:

1. Press MENU to show the menu bar; choose Spell Check All from the
Option menu. The DICT indicator on the status line is bighlighted
and the Spell Check dialog box appears:

<< SPELL CHECHK >>
START POSITION SET

Use cursor o select and press RETURRML

[(=NISEEHNN [TOP OF FILE] [ICANCEL]

2. Press « and — to select and press RETURN.
s CURRENT. Starts Spell Check from the current cursor position
» TOP OF FILE. Starts Spell Check at the beginning of the file
* CANCEL. Exits Spell Check

While Spell Check scans your file, this message appears:

Working....

If a misspelled word (a word not in the Spell Check dictionary or in your
User Dictionary) is found, this dialog box appears:

Spelling mistake!

[CAMCEL]

Press « and — to select and press RETURN.

* IGNORE. Leaves this word unchanged and resumes scanning. Use this
option for a word that is correct though not standard English and
when you do not want to add the word to your User Dictionary (a
name seldom used in your files, for example).
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* SUGGESTION. Gives a list of similar words. Press T and { to select the
correct word, and press RETURN to replace the misspelled word in
your file with the correct word automatically. If the word is not listed,
press CANCEL. If the system has nothing to suggest, press RETURN. In

both cases, you return to the Spell Check dialog box where you can
select another option.

Spelling mistake! EUEE[?HUM it

1

[CANCEL]

* RETYPE. Allows you to enter a word when you think it is faster than
asking for a suggestion, or when the system does not suggest a word.
Type the correct word in the dialog box, and press RETURN to replace
the misspelled word in your file and continue scanning.

WQORD: OuERENL

boen

Tupe word and press BETURRM,

* ADD. Allows you to enter the correct words not in the Spell Check
dictionary but which are correct and frequently used in your files. If

the word is accepted, it is inserted in your User Dictionary and this
message appears:

Word added to user dicticnary. -l

If you have no User Dictionary, the Desktop Publisher creates one. If
the word cannot be added to the User Dictionary, the dialog box

shown below appears. Press RETURN to return to the previous dialog
box:

Spelling mistake!
[ A-B ]

Inwalid for dictionary, FPrezzs RETLRMN.

Once a word is in the User Dictionary, Spell Check does not stop when
the word appears again.

* CANCEL. Stops Spell Check and returns to the document.

Redundant words

If a redundant word (a word that is repeated, like “and and”) is found,
this dialog box appears:

Redundancy aror!

[EINEIS| (ERASE SECOND WORDI] [CANCEL]

Press «<- and — to select the word and press RETURN.

* IGNORE. Leaves the word unchanged and resumes scanning
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* ERASE SECOND WORD. Automatically deletes the repeated word and
resumes scanning

* CANCEL. Stops Spell Check

Capitalization mistakes

If 2 word with incorrect capitalization is found, this dialog box appears:
(The procedure is the same as when a misspelled word is found.)

Capitalization errar!
DEnwver ]

[CANCEL]

Check during Typing ON/OFF (Spell Check)

When you select Check during Typing ON/OFF from the Option menu,
the DICT indicator on the status line is highlighted, and Spell Check
checks your text as you type it. Unless you make mistakes, you do not
notice that Spell Check is running. When you make a mistake (misspelled
or redundant word, capitalization mistake), the appropriate dialog box
appears. Continue as you would with the Spell Check All option.

To turn this feature off, select Check during Typing ON/OFF from the
Option menu.

User Dictionary Maintenance

The User Dictionary allows you o Spell Check comes with a built-in dictionary containing standard English

add new words, delete old ones [ ..
’ i ' rds. nnot change the built-in dictionary.
save the User Dictionaty file on words. (You ca & ry-)

diskette, or load a User

Dictionary file from diskette. Spell Check also, however, stops at such words as people’s names,

company names, or other non-English words, even if they are correct. To
prevent this from happening, create your own dictionary. When you have
such a User Dictionary in memory, Spell Check does not stop at a word
that is in your User Dictionary.

You create a User Dictionary when you select Add in Spell Check to add a
word to the dictionary.

This dictionary is held in memory as long as the Desktop Publisher is
turned on. If you add words to the User Dictionary and want to use the
same dictionary for checking other files, save the User Dictionary onto a
diskette before turning your system off. Later, when you want to use that
same dictionary, load the dictionary from the diskette. When working with
the User Dictionary, keep the following limitations in mind:

* Each diskette can hold only one User Dictionary. If you save a User

Dictionary onto a diskette that already contains one, the dictionary
previously on the diskette is overwritten by the new user dictionary.
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The simplest way to add a word
to the User Dictionary is to
choose the ADD option in the
Spell Check dialog box. A second
way lo enter words in the User
Dictionary is to use the User
Dictionaty Maintenance option.

* The memory of the Desktop Publisher can hold only one dictionary. If
you create a dictionary in the memory and then load a dictionary from

a diskette, the one currently in memory is overwritten by the dictionary
loaded from the diskette.

P To add a word to the User Dictionary:

1. Press MENU to see the menu bar; show User Dictionary Maintenance
from the Option menu. The User Dictionary dialog box shown below
lists the words in the current User Dictionary:

<< USER DICTIONARY MAINTENANCE >> vl rrifsuin])

WORD:
TOTAL:

O word(s)
d, bvpe ward and press RETUR

M. Fress MEBNL for ather

aphions,

2. Start typing the new word. The cursor moves to the entry field at the
top of the dialog box.

3. Press RETURN. The word appears in the list.

pTo edit the User Dictionary:

1. Press MENU to see the menu bar; select User Dictionary Maintenance
from the Option menu. The User Dictionary dialog box lists the words
in the current User Dictionary.

2. Press MENU to see the menu bar; press O to select the Operate
menu. You can select from the following options on the Operate
menu:

* Delete. Deletes a word (shortcut: CODE + D). This message
appears:

\Move cursor to delete and press RETURN.

Press T or | to select the word you want to delete and then press
RETURN.

* Delete All. Deletes all entries. This dialog box appears:

OK to deiete all words in user dictionary?
Use cursor to select and press RET RN
[T ES]

(O]

Select YES to delete all words or NO to cancel.

* Load. Loads a User Dictionary file from a diskette. Before
selecting Load, insert a diskette with a User Dictionary in the disk
drive. If a User Dictionary is already in memory, this dialog box
appears:

Usaear dictionary already exists in memory!
Cvarwrite™

Use cursor to select and press RETURNL
[MNC]

Select YES to overwrite the current User Dictionary or NO to
cancel. Remember that you can have only one User Dictionary in
the memory.

OR

Word Processing 63



If the diskette does not contain a User Dictionary, this dialog box
appears:

Insert disk with user dictionary file you created and retry.

Use cursor to select and press RETURN.
RETRY] [CANCEL)

Insert another diskette and select RETRY or select CANCEL to quit.

* Save. Saves the User Dictionary on a diskette. Before you select
Save, insert a diskette in the disk drive. If the diskette does not
contain a User Dictionary, the current User Dictionary is saved
immediately. If the diskette already contains a User Dictionary,
this dialog box appears:

User dictionary already exists on disk!
Overwrita?

Use cursor to select and press RETURRM.

[TEZ] [NO]

Select YES to overwrite the User Dictionary stored on the diskette
or NO to cancel. Remember that you can have only one User
Dictionary on a diskette.

* Exit. Exits from the User Dictionary mode.

pTo use Type Thesaurus (with the word “book” as an
example):
1. Instead of typing the word in your text, press MENU to show the
menu bar; choose Type Thesaurus from the Option menu. The
thesaurus asks for a word:

<< TYPE THESAURUS >>

SPECIFIED WORD:

Type word and press RETURN.

2. Type the word (“book” in our example) and press RETURN. 7he
Thesaurus dialog box appears:

[T <sPeciritD woRD = book ]
MEANING{S): Vertbl Verb2

ect MEAMING.

tward and press RETURMN.

MEANING(S). Lists the possible parts of speech for the specified
word. In our example, “book” can be a noun or a verb.

3. Press « and — to go from one column to the other. Press Tand | to
move inside a column.

4. Press RETURN to insert the selected word in your text or CANCEL if
you cannot find an appropriate word.

¢ If the Desktop Publisher cannot find a synonym for the specified
word, this message appears instead of the Thesaurus dialog box:

<< TVPE THESAURUS 55

SPECIFIED W No synonyms! -
Press any key to continue.
Tup2 ward and press
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pTo use Edit Thesaurus:

;’;:Wi‘tgfzsizf;zgﬁfg i 1. Move the cursor to the word that you want to replace. Press MENU
to show the menu bar; choose Edit Thesaurus from the Option

a better synonym automatically.
Use this function when revisin menu. The Thesaurus dialog box appears.
<] g pp

text.
[ < SPECIFIED WORD » play 1
MEANING($): Noun2 Noun3 Nound Nouns
game _____________ ] sport

select MEANING,

Press +, 4 to select word and press RETURR.

2. Select a synonym in the same way as you would with the Type
Thesaurus function. Press RETURN to replace the current word with

the selected synonym.

Using the Screen Menu

Print
Scale Lina OMNICFF
Funclion Mark ONIOFF &

Use the Screen menu to turn on/off the scale line, use text symbols, or
Color Mark.

Screen I » Scale Line ON/OFF. Switches the scale line on or off
Function Mark ONIOFF T

Colar Nark ON{OFF

* Function Mark ON/OFF. Switches the text symbols on or off

s Color Mark ON/OFF (below Function Mark ON/Off). Makes the
colored text stand out.

Scale Line ON/OFF
The Scale Line ON/OFF option allows you to change the viewing space
for your documents.
Press MENU to see the menu bar; select Scale Line ON/OFF from the
Screen menu. The Scale Line switches on and off.
Function Mark ON/OFF
If Function Mark is tumed off, the  The Function Mark ON/OFF option allows you to turn the text symbols
Color Mark also disappears. (such as Return or Page Break symbols) on or off. Press MENU to see the
menu bar; select Function Mark ON/OFF from the Screen menu.
Color Mark ON/OFF

The Color Mark ON/OFF option allows you to recognize the colored
characters and easily edit them. ‘

If Color Mark ON/OFF is turned on, the colored text will have a line

above the text.
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Using the Print Menu

Screen m

- i

If you specify a starting page
number that does not exist,
printing will not start.

This model prints faster with the
black inkjet cartridge; therefore,
use a black cartridge for black
text and save the color cartridge
for color printing only.

BT s 00 5 [

Ouvevianae CelaanrZaa :....3....;....4....:....5....:....6.
The Caolor Tnkjet Deskiop Publicherd
ECreate stylized documents, newsletters and brochures wit

EF_IJLeTTERT [HelldalBlk]

If Color Mark On/Off is selected again, the screen returns to normal
mode.

The default when opening the file is always “Color Mark is Off.”

Use the Print menu to preview and print your document,
¢ Print. Prints your document
* Layout. Previews your document so you can proof it before printing.

pTo print a document:
1. Press PRINT. The Word Processing Print Menu dialog box appears:

STARTIMG PAGE: 1 HEADER PRINT: VES
ENDING PAGE: 389 FODTER FRINT: YES
NUMBER OF COPIES: i COLOR PRINT: NOQ
PRINT BUALITY: MEDIUM MERGE PRINT: HO

{FILENANME: MRG])

Type nurnbar and press RETURMN.

2. Press T, , «, and - to move the cursor to a setting. Type the
values or press the SPACEBAR to change settings. Press RETURN
when you finish.

* STARTING PAGE: The page number of the first page you want to
print

¢ ENDING PAGE: The page number of the last page you want to
print. (The ending page number must be greater than the starting
page number.)

¢ NUMBER OF COPIES: The number of times you want the
document to print (maximum 999)

s PRINT QUALITY:
FINE—For final copy quality printing
MEDIUM—For average print quality
DRAFT—For trial printing. (You save time and ink with this
setting.)
e ENVELOPE PRINT:
YES—For printing on envelopes only
NO—For printing on normal paper
* HEADER PRINT:

YES—Prints headers (has no effect if you have not defined
headers)

NO—Prints without headers
* FOOTER PRINT:
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YES—Prints footers (has no effect if you have not defined
footers)

NO-—Prints without footers
* COLOR PRINT:

YES—If color inkjet cartridge is installed on the machine, the
document will print in color. (Even if YES is selected, your
document will print in monochrome when using a
monochrome inkjet cartridge.)

NO—The document will print in monochrome. Using a
mono-inkjet cartridge is recommended.

* MERGE PRINT:

YES—Merges information from an Addressbook file into your
document. When you select Yes, this message appears:

Press TAB to open MERGE FILE INDEX. —l

Press TAB to list Addressboock files on the diskette.

Press the arrow keys to select a file name and press RETURN.
The file loads and the file name appears under MERGE
PRINT/YES.

NO—Prints without merging. (This setting cancels merge
printing even if you have selected an Addressbook file.)

The maximum length of paper 3. Press RETURN when finished. This message appears:
that can print is 14 inches.
Printing....press CANCEL to stop printing. l

If you press CANCEL to stop printing, this dialog box appears:

OK to cancel printing? I

Use cursor to select and press RETURRNL
= [NO]

K==

Select YES to cancel printing or NO to continue printing.
* If the paper has not been inserted or is jammed or cannot be
gjected, this message appears:

Faper feed problern!
Insert papear correctiy.
OWK to continue printing?

Use cursor to select and press RETURRN.
S [NO]

(vES

You may wish to turn the machine off before attempting to
remove the jammed paper manually. (Be sure that the information
is stored on the disk before turning off the machine.)

OR

Press CODE + SHIFT + HELP to eject the paper; select YES to
continue printing or NO to cancel.
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* If the paper is shorter than specified in Page Setup, this message
appears:

Incorrect paper size!
Check page setup menu or insert correct paper.
QK to cancel printing?

se cursor ta

select and press RETURTM.

[NO]

Select YES to cancel. Select NO to restart printing. The part of the
Previous page that could not print, prints from the top of the new
sheet of paper.

* If the text extends outside the printable area, printing stops and
this message appears:

Data will be truncatead!
Check page setup menu and margin settings.
Do you still want to continua printing?

Use cursor to select and press RETURM.

NS

Select YES to truncate (cut off) text and continue printing or NO
to stop printing to check margin settings.

The system always checks the type of ink cartridge installed on
the machine. If the setting Color Print does not match the type of
inkjet cartridge, one of the two following messages appear:

Printing....press CANCEL to stop printing.
Use black ink cartridge to print this data at best
quality and speed.

Printing....press CANCEL to stop printing.
Printing with black ink carltridge.
Use color cartridge to print color.

Delay printing
Press CODE + SHIFT + W to delay printing for any reason. The
Jollowing screen appears:

<< PAPER INSERTION »>

Freszs SFACE to change setting and press RETLIR M.

Press SPACEBAR to select a setting.

* AUTO—Feeds the paper without a delay

e 15-SECOND WAIT—Loads the paper 15 seconds after printing each
page

* 30-SECOND WAIT—Loads the paper 30 seconds after printing each
page

* MANUAL—Asks you to insert a paper manually. Each time printing a
page is completed, the message “Press RETURN to continue printing.”
appears. Set the paper and press RETURN to insert paper.
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Merge Printing

Merge symbols with a label name that does not exist in the Addressbock
file are ignored. The same happens when there is no information in the
Addressbook for the specified record.

If you select Merge Print/No for a document that contains Merge symbols,
the label names print as they appear on screen.

Using Layout to Preview a Document

Press T to preview the previous The Layout option allows you to preview a half page as it appears when
half page, and | to preview the you print it. (In a multipage document, the previewed page is the one the
next half page. ;

cursor is on when you start.)

1. Press CODE + LAYOUT.

2. Press RETURN to teturn to the Input/Edit screen. The page shown last
in the Layout screen appears.

Word Processing 69



Word Processing 70



2 Addressbook

Use Addressbook to enter and organize information such as a list of names, addresses, telephone
numbers, and fax numbers.

Each entry is called a record and appears as a single row divided into several items. On the top of the
list of records, labels identify each item. You can edit, sort, and print the list. Parts of the list can be
selected according to specific conditions.

You may also use Addressbook files with Merge printing to create multiple copies of a document
created in Word Processing. Merging information in this way can prove useful if you have, for example,
a form letter that you want to send to several different people. You could create an Addressbook file of
information to be inserted using merge codes and match each one to a different record in the
Addressbook. After arranging these two files, you would tell the desktop publisher to merge them.
When you print, you should have several customized versions of your form letter.

When you save an Addressbook file, the system adds the extension .MRG to the file name. Files with
that extension can be used for merge printing with Word Processing files.

p-To create a new Addressbook file or look at a stored one:

If you get a message that you 1. Turn the power on to show the Main Menu.
have an unformatted or damaged \ . .

iskett
diskette, either replace the 2. ?‘0 look at. an Af:ldressbook file from a diskette, insert that diskette
diskette with another or go to into the disk drive.
page 16 in Getting Sta’_fe,t‘f f‘,” 3. Press 2. If you insert a diskette, the list of the Addressbook files stored
fgj:f(r:;gons on how fo initialize a on the diskette appears.

E Word Processing 5 { MRE) Addressbook
[ kHELEDOE

—

Remember that you can press 4. To open a stored file, press the arrow keys to select the file you
HELP to get on-screen help. want to look at and press RETURN. To open a new document, press

RETURN with *NEWBOOK selected. If you retrieve ar existing
Addressbook file, the View screen appears. If you start a *NEWBOOK,
the Data Input screen appears, and you can enter your first record.
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Using Addressbook Screens

View Screen

If you are at the View screen,
press RETURN to display the
Data Input screen.

if you are at the View screen,
press RETURN fo see the Data
input screen.

Data Input Screen

If you are at the Data Input
screen, press CODE + RETURN
to ses the View screen.

Addressbook uses two screens: the View screen and the Data Input
screen.,

The View screen appears when you open an existing Addressbook file.

(MRG ﬂBGUK 1 |RECOFID= 1
[ THR/HS]TLAST NAME FIRST NAME TELEPHONE
| Pl |Fletcher |Lawrercs |201-272-

Connhelly Patrick
Harrison

The View screen gives a list of your records. Use the View screen to make
large-scale edits, such as moving or deleting a block of records or sorting
records. You cannot edit the contents of a record from this screen.

The check marks at the left of the records indicate they are selected for
printing. (A new record that you create is automatically selected for
printing.) For more information about selecting a record for printing, see
page 78.

The Data Input window appears when you open a new file. Use it to
create a new record for an Addressbook file.

%
oy
[—+
=i
)
:x:l
=
—

MRe __ JBOOK1 [rECORD: 1}

MRS HMS M e eeeeaa—————————————n
LAST NAME Fletcher

The Data Input screen appears as an empty record when you enter the
information for that record. You can edit this information after it is
entered.
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Working with Addressbook

When creating or editing an Addressbook file, keep the following points
in mind:

* You can set the width of a column between one and 71 characters.

* You can have 2 maximum of 20 different labels.

* The maximum length of a label name is 12 characters.

File Menu

Input_ Regord The File menu is available on both the View and Data Input screens. Use

SITLLK . the File menu to open, save, or close your files and to return to the Main
i ' .

2per - Menu or go to File Management. These menu options work the same in

the Word Processing program. For more information, see Using the File

lnput Regord
Menu on page 33.

Cluse File

EA input Regord

Fila hdanagernent

If you get a message indicating
that you have an unformatted or
damaged diskette, either replace
the diskette with another one or
go to page 16 in Getting Started.
for instructions on how to initialize
a diskette.

Input Menu (View Screen)
Use the Input menu to create a new record or move to the top or bottom

I8 Record  Label of the list.
Top Record + ¢ New Record. Creates a new record
Regord  Label '
TN Record Labe * Top Record. Jumps to the first record

Top Record +
» Bottom Record. Jumps to the last record

New Record
The New Record option allows you to add a new record at the end of
your Addressbook.

Press CODE + R. The Data Input screen appears.

The entry fields will be empty. The new information that you enter
appears at the end of your list when you return to the View screen.
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Top Record
Use Top Record to move to the first record of your Addressbook file. The

record appears on the Data Input screen.

Press MENU to see the menu bar; select Top Record from the Input
menu.

Bottom Record
Use Bottom Record to move to the final record of your Addressbook file.

The record appears on the Data Input screen.

Press MENU to see the menu bar; select Bottom Record from the Input
menu.

Record Menu (View Screen)
Use the Record menu to change the location or appearance of an entire
block of text.
* Move. Moves records from one location to another location in
Addressbook
* Copy. Copies records to another location. The original records are not
changed.

Celate t
nzerk » Delete. Removes records

s Imnsert. Inserts a blank record

- To move a block of records:
This option removes a block of 1. To move records, place the cursor on the first record to be moved.

records from its original location ,
and placss it at ancther location. 2. Press CODE + E. This message appears:

[Move cursor to end of block to be moved and press RETURN. J

3. Move the cursor to the end of the block. As the cursor moves, the text

is highlighted.
4. Press RETURN when the block is highlighted. This message appears:

|Move cursor to destination for blocked record and press RETURN.

5. Move the cursor to where you want the records placed and press
RETURN. The records are removed from their original location and

placed at another location.

pTo copy a block of records:

1. To copy records, place the cursor on the first record to be copied.

This option copies a block of
records to another location A
without removing the original 2. Press CODE + C. This message appears:
records.
|Move cursor to end of bleck to be copied and press RETURN.
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3. Move the cursor to the end of the block. As the cursor moves, lext is
bighlighted.
4. Press RETURN when a block is highlighted. This message appears:

IE)ve cursor to destination for blocked record and press RETURN. —|

5. Move the cursor to where you want the records placed and press
RETURN. The records are inserted,

p-To delete a block of records:
:Z’ciz ’;P;ﬁm removes a block of 1. To delete records, place the cursor on the first record to be deleted.
’ 2. Press CODE + D. This message appears:

,Move cursor to end of block to be deleted and press RETURN. J

3. Move the cursor to the end of the block. As the cursor moves, text is
bighlighted.

4. Press RETURN when a block is highlighted. The desktop publisher
asks you to confirm.

Detete?
Use cursor to select and press RETURN.
=3 [NQY]

5. Select YES to delete the block or NO to cancel.

Insert
This option inserts a blank record.

1. Move the cursor to the place where you want a blank record.
2. Press INSERT. A blank record appears.

Label Menu (View Screen)
Use the Label menu to create, change, or delete labels. The labels are the

names at the top of each column.
Delets Label
¢ Insert Label. Creates a new label
Delate Label
Change Label Marme & YWidth * Delete Label. Deletes a label

* Change Label Name & Width. Edits a label name and changes the
label width

pTo insert a label:
This option creates a new label 1. Press MENU to see the menu bar; select Insert Label from the Label
and sets the name and width of menu. This message appears:

the label,

lMove cursor to position for insert label and press RETURN.
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The maximum number of labels 2. Move the cursor where you want a new label and press RETURN.

you can create is 20. s . .
The maximum length for a label This dialog box appears

name is 12 characters.
The width of a column must be
between 1 and 71 characters.

<< INSERT LABEL »>>

LABEL NAME: [ |

LABEL WIDTH: 12

Type label name and press RETURNM.

3. Press T and | to move to an entry field. Type a label name and a
value for the width. Press RETURN.

P To delete a label:

This option removes columns of 1. Press MENU to see the menu bar; select Delete Label from the Label

information together with their )
labels. menu. This message appears:

IMove cursor to start of block to be deleted and press RETURN.

2. Move the cursor to the beginning of the block of labels you want to
delete and press RETURN. This message appears:

Move cursor to end of block to be deleted and press RETURN.

3. Move the cursor horizontally to the end of the block of labels you
want deleted. As the cursor moves, the selected labels are bighlighted.

4. Press RETURN when a block is highlighted. The Desktop Publisher
asks you to confirm.

Delete?

Use cursar to select and press RETURN.

[TEZ] INO]

5. Select YES to delete the block or NO to cancel.

P To change a label name and width:

1. Press MENU to see the menu bar; select Change Label Name & Width

The maximum length for a label from the Label menu. This message appears:
name is 12 chatacters.

The width of a column must be

iti £ hange and press RETURN.
betwaen 1 and 71 characters. |Move cursor to position for chang P

2. Move the cursor to the label that you want to change and press
RETURN. This dialog box appears:

<< CHANGE LABEL »>

LABEL NAME: BIRTHDAYH
LABEL WIDTH: 12

Type label name and press RETURN.

3. Press T and | to move to an entry field. Type a label name and a
value for the width. Press RETURN.
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Edit Menu (View Screen)

Use the Edit menu to sort your records and to select records from the file.
| * Sort. Sorts the records
* Select. Selects records

pTo sort records:

This option rearranges the 1. Press MENU to show the menu bar; select Sort from the Edit menu.
records in alphabetic order. This message appears:

The sort option can perform a .

double sort, primary and LMove cursor to primary sort label and press RETURN. ]
secondary. Usually, you use the

family name for primaty sort, and 2. Move the cursor to the primary sort label and press RETURN. This

the first name for secondary sort.
message appears:

rMove cursor to secondary sort label and press RETURN.

3. Move the cursor to the secondary sort label and press RETURN. If
you do not need a secondary sort, leave the cursor on the primary

sort label. This dialog box appears:

Direction?

4. Press « and — to select and press RETURN when you are finished.
¢ ASCENDING. Normal alphabetic order (A-Z)
¢ DESCENDING. Reverse alphabetic order (Z-A)
¢ CANCEL. Cancels the function

p-To select records:

This option selects records that 1. Press MENU to see the menu bar; choose Select from the Edit menu.

match your selections. When the Y )
records are found, you can print This dialog box appears
them. MR/MS

LAST NAME

Twpe character and press RETURRM.

2. Press T and | to move to an entry field. Type in the information.

3. Press RETURN. A/l entries that match your conditions are selected.
A message tells you if the Addressbook cannot find any record that
matches your selection.

If the Addressbook can find record(s) that match your selections, those
records appear in the Selected Data dialog box:

[Mes _ FBROOKL RECURD: 1]

MR/MS D e eeem e e e e e amaemmean
LAST NAME Fletcher | rrommmmmmmsmmmmmemmmmees
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4. If necessary, press the arrow keys to scroll through the information
appearing on the screen. Press RETURN to print the selected
information or CANCEL to cancel this function.

Print Menu (View Screen)

Use the Print menu to select records for printing and to print your

Addressbook:
Print Record OMNIGFF

* Print. Prints envelope labels (Label printing) or a list of records (List
printing)

e Print Record ON/OFF. Sets the check mark (¢) to turn printing on or
off

pTo print labels:

1. Press PRINT. The Addressbook Print Menu appears:

PRINT APPLICATION: LAOBEL
PRINT RECORD: ALL LABEL SIZE:

: 1X 258
PRINT POINT: 12 POINT NUMBER OF LABELS: ACROSS 2

PRINT QIUALITY: MEDIUM

NUMBER OF COPIES: 1

Presz SPACE to change selting and press RETURM,

2. Use T or | to move to a setting. Press SPACEBAR to alternate
between settings.

3. Press RETURN when finished.

Using Customized Labels

If OTHER is selected in LABEL SIZE on the ADDRESSBOOK PRINT menu,
the following message appears:

rPress TAB to change setting and press RETURN. I

<¢ LABEL SIZE >

LABEL HEIGHT: 1. TOP MARGIN:
LABEL WIDTH: 2.58 LEFT MARGIN:
GUTTER: VERTICAL
HORIZOHTAL

Tupe number and press RETURMN. Prass +, 4, +, » to move to another sething.
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The kind of label that you create
will be stored in the file.

If you press CANCEL while the
cursor is in the right box, the
setting of the current label name
is canceled, and you refurn to the
left box. If you press CANCEL
while the cursor is not in the right
box, you return to the
Addressbook Print Menu.

The default settings for the label
structure and contents appear
only when you are working with
an Addressbook file in which you
have not inserted or deleted the
label and changed the label
sefting.

P To change label settings:

PRINT APPLICATION: LABEL. Prints envelope labels
PRINT APPLICATION: LIST. Prints a list of records
PRINT RECORD: ALL. Prints all records

PRINT RECORD: SELECTABLE ( ). Prints only selected records
indicated with a check mark.

PRINT POINT: 12, 10, 7 POINT. Selects the character size
PRINT QUALITY: FINE. For final quality printing

PRINT QUALITY: MEDIUM. For average quality printing
PRINT QUALITY: DRAFT. For trial

NUMBER OF COPIES: The number of times the paper is to be printed
(maximum 999). In label printing, the number of times the label is to be
printed.

LABEL SIZE: 1x25/g,11/3x4,4x1,4%2,3 1/3 x4, or OTHER. (The
size of the labels is in inches.)

NUMBER OF LABELS: Type in the kind of labels to be used. (The valid
information is Across = 1-9 and Down = 1-99.)

. Check the size of the label you wish to use, and type in its number.

If you press RETURN after typing in each value, the Position Set

Print menu appears.

If incorrect information is typed into the ADDRESSBOOK PRINT menu,
the following messages may appear:

[Label exceeds boundary of the paper! J

[Incorrect setting! |

pTo change label position settings:
1. Select LABEL before printing and press RETURN to enter the settings

of the ADDRESSBOOK PRINT menu. The POSITION SET PRINT menu
Jfor label printing appears:

SPACE to sel, DELETE lo ¢lear.

elect tabel narne snd press
L[ to starl printing.

2. Press T and 4 to move the cursor to a label name in the Position Set

menu.

3. To remove a label name that is already set, press DELETE. The

check mark on the left of the label name disappears, and the small
letter corresponding to that label is removed from the right box.

4. To set a label name, press SPACEBAR and the cursor appears in

the right box. Use the arrow keys to move the cursor in the right
box to a position and press RETURN to confirm the setting. When
the cursor appears in the left box, a ¢ appears.
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You can set Print Record, Print
Point, and Number of Copies as
you would when printing labels.
Label Size does not appear on
this dialog box. Instead, you can
set the page dimensfons using
FPage Setup. The current paper
size is indicated at Page Setup in
the Addressbook Print menu.

5. Repeat steps 1 and 2 to get all necessary items at the correct location.

6. To start printing, set the paper on the paper support and press
RETURN when the cursor is not in the right box.

pTo print a list:
1. Press PRINT. The ADDRESSBOOK PRINT menu appears.

Press T and | to move the cursor to PRINT APPLICATION and press
SPACEBAR to select LIST. The ADDRESSBOOK PRINT menu changes
as shown below:

PRINT APFLICATION: LIST)

PRINT RECORD: ALL PAGE SETUP: LETTER
FRINT PQIMT: 12 POINT

FRINT QUALITY: MEDIUM

NUMBER OF COPIES: 1

Fresz SPACE to change setting and press RETURMN.

pTo change Page Setup:

1. Move the cursor to PAGE SETUP on the Print Application menu;
press TAB to change the page setup. 7he Page Setup box appears:

PAPER $IZE: LETTER

TOP MARGIN: _1.900 PAPER LENGTH: 11.00
BOTTOM MaRGIN: _1.00 PAPER WIOTH: g.80
LEFT MARGIN: _1.00 DATA LENGTH: .00
RIGHT MARGIN: 1,00 DATA WIDTH: £.50

Press SP&CE to change setling and press RETURN.

2. Press SPACEBAR to select the paper size and orientation. This
determines the width and length of the paper and the margins.

3. Press the arrow keys to move the cursor to the entry field for each
margin setting and type a value in inches.

* You can move the cursor to the underlined fields only. The
margin entry fields are always underlined. The width and length
are underlined only if you select OTHER for the paper size.

» Each field has room for five characters (four digits and a decimal
point). Pressing BACKSPACE or DELETE clears the whole field.

e If the Data Area width is less than 1 inch or its length is less than
4 inches, this message appears:

ﬁncorrect setting! J

 With OTHER, if you set the width to more than 9..5 inches or the
length to more than 14 inches, this message appears:

IIncorrect setting! |

4. When finished, press RETURN to go back to the ADDRESSBOOK
PRINT menu.
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If you press CANCEL while the
cursor is in the right box, the
setting of the current label name
cancels and you retum to the left
box.

If you press CANCEL while the
cursor is not in the right box, you
retum to the ADDRESSBOOK
PRINT MENLU.

5. Press RETURN at the Label setting to see the Label Set Print Menu where
you decide the contents and structure of the list you want to print. The
left box shows the list of labels of the current Addressbook file, preceded

by a small letter. The right box shows the contents and structure of the
list.

<< LABEL SET PRINT MENU »5

77— (NEEEERNEERENENRRNEEE|
o !

b.LA SETTING CHARACTER:

ST HAME PRINTABLE CHARACTER: B5
Use cursor to select [abel nare and press SPACE t seh, DELETE to clear.
Fress RETURN ta start printing. )

6. To remove a label name that is already set, press {X]. The check

mark at the left of the label name disappears, and the small letter
corresponding to that label is removed from the right box.
To set a label name, press SPACEBAR and the cursor appears in the
right box. Use the arrow keys to move the cursor in the right box to a
position and press g to confirm the setting. When the cursor moves to
the left box, a v appears.

7. Repeat steps 1 and 2 to get all the necessary items in the correct

location.
As you add labels, Addressbook automatically shows the label width to be
printed. The total width, according to the selected character size and your
page setup, also appears. If you set too many labels in the records to be
printed, so that their length exceeds the printable length, your records are cut
off.

8. To start printing, set the paper on the paper support and press
RETURN when the cursor is not in the right box. See To start
printing on page 82.

pTo change label print settings:

1. Select LABEL gefore printing and press RETURN to enter the settings
of the ADDRESSBOOK PRINT menu. The POSITION SET PRINT menu
for label printing appears.

2. Move the cursor to a label name in the left box of the Label Set Print
dialog box.

3. To remove a label name, press DELETE. The check mark at the left
of the label name disappears, and the small letter corresponding to
that label is removed from the right box. :
To set a label name, press SPACEBAR and the cursor appears in the
right box. Use the arrow keys to move the cursor in the right box to a
position and press RETURN to confirm the setting. When the cursor
moves to the left box, a v appears.

4, Repeat steps 1 and 2 to get all necessary items in the correct
location.

As you add labels, Addressbook automatically shows the label width to be
printed. The total width, according to the selected character size and your page
setup, also appears. If you set too many labels in the records to be printed, so
that their length exceeds the printable length, your records are cut off.,
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P To start printing:

;he maximum length of paper 1. Set papers on the paper support and press RETURN while the cursor
at can print is 14 inches. is not in the right box

When label or list printing starts, this message appears:

[ Printing....press CANCEL to stop printing. ]

2. Press CANCEL to cancel printing. This dialog box appears:

OK to cancel printing?
Use curser to select and press RETURN. |
[YES] {NO]

3. Select YES to cancel printing or NO to cancel the function.

Selecting records for merge printing

This feature turns the check mark on or off that appears at the left of the
records on the View screen.

During merge printing in the Word Processing program, records without
the check mark are ignored. (A new record is automatically active.)

During label or list printing, only records with a check mark print if you
select PRINT RECORD: SELECTABLE (¢). If you select PRINT RECORD:
ALL, the check marks make no difference.

pTo select records for printing:

1. Press MENU to see the menu bar; select Print Record ON/COFF from
the Print menu. A dialog box appears:

How do you set print record onfoff?

|Use cursor to select and press RETURN.
Ieseess) (ALL RECORD ONj [ALL RECORD OFF! {CANCEL]

2. Select the setting and press RETURN.
» CHOICE. Sets the check mark on or off for a block of records
e ALL RECORD ON. Sets the check mark on for all records
» ALL RECORD OFF. Sets the check mark off for all records
* CANCEI. Cancels the function. '
When you select CHOICE, this message appears:

Use cursor to select and press SPACE for print record on/
off. Press RETURN.

3. Move the cursor to a record and press SPACEBAR to turn the check
mark on or off. Press RETURN when you finish.

You can also select the record on the View screen and press SPACEBAR
to make a record inactive. The check mark of the selected record
disappears. Pressing SPACEBAR again reactivates the record.
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Jump Menu (Data Input Screen )

durnp Use the Jump menu to create a new record, to show the top or the
bottom record, or to search for a piece of information.

Jop Record +

* New Record. Creates a new record

* Top Record. Shows the first record
* Bottom Record. Shows the last record

* Search. Searches for a piece of information

ZZUDCEa!: aés-ihf::fress'r > move The first three options (New Record, Top Record, and Bottom Record)
fo the top record or CODE + G work the same way as the options on the View screen. For information,
then press | to move to the see Input Menu (View Screen) on page 73.

bottom record.
p-To search for an occurrence of certain text:

1. Press MENU to see the menu bar; select Search from the Jump menu.
The Search dialog box appears:

SEARCH H
SEARCH: =< e [overJir]

START POSITION: CURRENT SEARCH: WHOLE WORD CHECK oFfF
CASE CHECK OFF

Tope SESRCH word(s) and press RETURN.
2. Define the text and other settings as you would in Word Processing.
For information, see To search for text on page 38. When an
occurrence of the specified string is found, this dialog box appears:

Continue search?
Lse curzor to select and press RETURN,
[NOJ [CANCEL]

3. Select YES to search for the next occurrence, NO to stop searching,
or CANCEL to return to the previous screen. When the text cannot be

Sfound, this message appears:

IWord(s} not found.

Label Menus (Data Input Screen)

Use the Label menu to create, change, or delete labels.
Cielete Label + ¢ Insert Label. Creates a new label

Labsl * Delete Label. Deletes a label

Deleta Label 1
iZhange Label Plarne & ¥YYidth

* Change Label Name & Width. Edits a label and changes the column
width

All these options work the same way as on the View screen. For

information, see Label Menu (View Screen) on page 75.

Screen Menu (Data Input Screen)

Use the Screen menu to control the display on the screen.
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¢ Return to View Screen. Returns to the View screen

Return to View Screen

This option returns to the View screen after editing or creating a record on
the Data Input screen.

Press CODE + RETURN. 7he View screen appears.
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3 File Management

The File Management program allows you to organize and convert your files on a diskette. The index
screen of the File Management program lists all files.

All operations, except disk copy, can be started from the menu bar.

p-To start File Management:
Please note that only

1. Turn on the i
MS.DOS formetted 1.44 MB t- powTer to see the Main Menu.
ME-2HD and 720 KB MF-2DD 2. Insert a diskette into the disk drive.

diskettes can be used on your 3, Press 3. The list of files a .
Desktop Publisher. If you get a f files appears:
message indicating you have an

unformatted or damaged disk,

either repface the diskette with <% FILE MANAGEMENT >> REMAIN: 1444.3 K] [ins]tiligsna]
aﬂOﬁ_hef or go fo page 16 in LETTERL WET ¢ ©.&» LETTERLO.WPT ¢ ©.6>

Gelting Started or page 89 in LETTER1I1.WPT ¢ ©.5) LETTERZ .WPT ¢ ©.B2

this chapter for instructions on Selecta file and prezs MEMNL. Fress CAMCEL to exit

how lo initialize a diskette.

The list of files stored on the diskette appears in the order shown in the
You can move the cursor fo the table below. The file names are sorted alphabetically for each of those

file you want to sefect by pressing  classes. The number following each file name gives the size of the file in
the first character key of the file kilobytes.

name. For example, if you press
C, the cursor moves to the file

whose name starts with a C. Type of File File Name & Extension
Your Desktop Publisher can only Word Processing ANYNAME.WPT
search Word Processing files .
when the cursor is Jocated at the Word Processing Templates ANYNAME.WP1
extension .WPT. Press TAB o Addressbook ANYNAME.MRG
to the next
Z’;:;;gicwsor °ne Addressbook Templates ANYNAME.MR1
Clip Art ANYNAME.BIM
User Dictionary SPELLUSR.DCT
ASCI ANYNAME.TXT

When using Desktop Publisher files in a personal computer, and vice
versa, remember the following points:

* Your system can only read and write from the root directory of a
diskette. Do not create any directories on the diskette.

* When creating or renaming a file with your personal computer, make
sure that you use correct file name extensions. There are two major
errors in working with extensions that you must avoid:
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1. The first error is to change the file name extension of a file that has
been created on your Desktop Publisher. For example, if you use
your personal computer to change the extension .WPT to .WP, your
Desktop Publisher will not recognize the file and will not show it on
the index or the File Management screens.

2. The second error is to create a file (using one of the above file name
extensions) in a format that cannot be recognized by your Desktop
Publisher. If you use your personal computer to create a file, giving
that file the file name extension .WPT, the file appears on the index
and File Management screens, but your Desktop Publisher will not
be able to open or convert the file.

Making a Backup Copy of a Diskette

The disk copy command copies all information on a diskette to another
diskette (backup copy). Disk copy does not appear on the menu bar.

CAUTION:

Copying an entire diskette to another diskette destroys any
information that may be on the destination diskette. Check the
destination diskette before starting. Make sure your destination
diskette has been initialized.

P To make a backup copy of a diskette:
1. Press CODE + SHIFT + O. This message appears:

I?nsert source disk and press RETURN. J
Disk copy is only between 2. Insert the original source diskette and press RETURN. The Desktop
diskettes that are formatted to the Publisher starts reading files from the source diskette. The Desktop

j th . , ; ) .
?:,r:;ts 'i«f,: !;:,?:Ovrecopi,g}?;:f a Publisher reads the first portion of the diskette; then this message

1,44 MB diskette to a 720 KB appears:
diskette, or vice versa.

Insert destination disk and press RETURN. I

3. Insert the destination diskette and press RETURN. The Desktop
Publisher transfers the files that bave been read from the source
diskette onto the destination diskette. It then asks you to reinsert the

source diskette.
Disk copy can be used only when 4. Repeat steps 2 and 3 until all files have been transferred to the
accessing File Management from destination diskette. You may need to swap these diskettes a number
the Main Menu. 115 not available f times before all fil ied to the destination diskette. The
if File Management is accessed of times before all files are copied to the destina cette.
through Word Pracessing or Desktop Publisher knows which diskette is the source diskette and
Addressbook. which one is the destination diskette. If you insert a wrong diskette,

this message appears:

Incorrect disk!
Press any kay to continue.
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Insert the correct diskette and press RETURN.
When copying ends, this message appears:

Disk copying completed. ‘,

Using the File Menu

Use File to copy, delete, rename files, and return to the Main Menu.
File Delete n * File Copy. Copies a file
* File Delete. Deletes a file

Fieturn te Main Meny . Bename. Changes the name of a file

¢ Return to Main Menu. Returns to the Main Menu

File Copy copies a file. You may copy to the same diskette or to a
different one. If the destination diskette is the same as the source
diskette, the file name must be different.

pTo copy a file:

1. Move the cursor to the file name that you want to copy. Press
CODE + C. This message appears:

Ensert destination disk and press RETURN.

2. To copy the file on the same diskette, press RETURN.

OR

To copy the file to another diskette, insert that diskette in the disk drive
and press RETURN. The File Copy dialog box appears:

<L FILE COFY >» FILENAmE: LETTER1M.WPT [REMAIN: 14448 KJ[INSPHUMISHA]
= EHisling File¢sy X -
LETTER1 .WPT ¢ ©0.8) LETTERLIO.WPT ¢ 0.8
LETTER11.WPT ¢ 0.5) LETTER2 .WPT ¢ 0.8

dpress RETURPM, Press T, 4 to serol e direciory.

Type filenarne an

This dialog box shows the files of the destination diskette that are
the same kind as the source file. The dialog box also provides an
entry field to type the name of the target file. When you type the
first letter of the file name, a list appears that starts with the file
alphabetically closest to that letter. It automatically scrolls to make
sure you do not enter an existing file name. To see another file
name, scroll manually using T or |.

3. To copy the file, type a file name that is not in use on the destination
diskette; press RETURN.
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P To delete files from a diskette:

1. Move the cursor to the file name you want to delete. Press
CODE + D. A check mark appears at the left of the file name. This
message appears:

Ifress SPACE to select file(s) and press RETURN.

2. Press the arrow keys to select a file name. Press SPACEBAR to turn a
check mark on or off to the left of the file name. Repeat this
operation to mark all files you want to delete; press RETURN. 7his
message appears:

OK to delete the selacted file(s)?

Use cursor to select and press RETURN.
[NO]

3. Select YES to delete or NO to exit and press RETURN. As files are
deleted, their file name appears. If you press CANCEL while a file is
being deleted, that file is still deleted. Other files marked to be
deleted, but which were not deleted before you pressed CANCEL,
are not deleted.

P To rename files on a diskette:

1. Move the cursor to the file name that you want to rename. Press
CODE + R. The Rename dialog box appears:

<4 RENAME >> FILENAME: LETTER1__.WPT [REMAIN: 1444.8 ﬁlmﬂ;ﬂumiismni
EHisting File(s) -
LETTERL .WPT ¢ 0.6> LETTER10.WPT ¢ 0.B)

LETTERLIL.WPT ¢ 0.5 LETTERZ .WPT ¢ 0.8}

Tupe filenarne and press AETURRM. Press 1, 4 ko zoroll file directory,

The dialog box shows the files of the current diskette that are of the
same kind as the selected file. The dialog box also provides an entry
field to type the new file name. When you type the first letter of the
file name, a list appears that starts with the file alphabetically closest
to that letter. The list automatically scrolls to make sure you do not
enter an existing file name. To see another file name, scroll using T
or i.

2. Type a file name not in use on the current diskette and press
RETURN to rename the file.

pTo return to the Main Menu:

Press CANCEL. This ends File Management and returns you lo the Main
Menzie.
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Using the Disk Menu

Use the Disk Menu to initialize diskettes, update the index, or print file
names on diskette.
Initialize Disk ¥

* Delete All. Deletes all unprotected files on diskette
Directory Read ¢
List Print

* Directory Read. Reads the directory of a diskette when this has not
been done automatically

* List Print. Prints all file names indicated on the screen

P To delete all unprotected files from a diskette (Diskette
Delete): :

All unprotected fifes on the root 1. Press MENU to see the menu bar; select Delete All from the Disk

directory are deleted with this .
option. This includes unprotected menu. This message appears:

files created on a PC that do not
appear in the index.

OK to delate alifiles on dish?

Use cursor to select and press RETURN.

2. Select YES to delete or NO to exit; press RETURN.

Initialize Diskette

A new diskette must always be formatted (initialized) before you try to
use it. You can also reformat a diskette that already contains information
in order to clear all files and subdirectories.

CAUTION:
Executing /nitialize Disk deletes all the information on the diskette.

You can format diskettes using either this Desktop Publisher or a personal
computer. If you use a personal computer, be sure to format the diskettes in
MS-DOS and use 2HD diskettes for 1.44 MB and 2DD diskettes for 720 KB.

pTo initialize a diskette:

Your Desktop Publisher uses both 1. Insert a diskette. This message appears if the diskette is unformaited or
MF-2HD and MF-2DD floppy a amage d:

diskettes, though the MF-2D0D '
has half the capacity of the
MF-2HD.

Unformatted or damaged disk!
Insert another disk and retry.

Usze cursar bo select and press RETURTM.
[CANCEL]

Whenever you use a diskette, the
File Management program

checks its format. It recognizes a
new diskefte or a diskette that is 2. Press CANCEL.

not formatted to DOS 1.44 MB or i1 . ,
DOS 720 KB. if the diskette is 3. Press MENU to see the menu bar; select Initialize Disk from the Disk

new, a prompt asks if you want to menu. This message appears:

initialize. Select YES fo initialize

the diskette (all contents will be , Do you want lo inilialize disk?
deleted). Al data on disk will be deleted if initialized.

Use cursor to select and press RETURN.
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4. Select YES to initialize or NO to exit and press RETURN.
If you select NO, initializing a diskette is canceled.
If you select YES, this message appears:

<< FORMAT TYPE »>

20D DISK T20KB

Use cursor to select and press RETURM.

Press T and ! to select a setting; press RETURN to start initializing the
diskette.

Directory Read
The directory of a diskette is usually read automatically each time you
insert a2 new diskette. In some circumstances, however, the directory is not
read automatically, and you may need to update the index manually.
P To update the directory manually:
Press CODE + F. The message “Working ...” appears while the
directory is being read.
P> To print a list of all file names on the screen:
Set the papers and press PRINT. A file names indicated on the
screen print as follows:
FILE LIST Used: 9.7K Free: 1447.9 K
LETTER] .WPT  (04)  LETTER2Z .WPT (04) LETTER3 .WPT (0.4) LETTER4 .WPT (0.4)
LETTERS WPT  (0.4)  LETTER6 .WPT (0.4) BOOK2 MRG (1.5) BOOK3 .MRG (L5)
BOOKiI MRG (1.5
Using the Convert Menu

Use the Convert menu to convert your Word Processing files to a PC or
make ASCII files available to your word processor.

* WP TEXT.WPT—ASCIL.TXT(Text Only). Converts a Desktop
Publisher file into an ASCII file (all format codes except TAB and
RETURN are removed)

* WP TEXT.WPT—ASCIL.TXT(Text Only). Converts a Desktop
Publisher file into an ASCII file (all format codes except TAB and
RETURN are removed)

¢ ASCILTXT—WP TEXT.WPT. Converts an ASCII file into a Desktop
Publisher file
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Conversions to or from ASCII files are carried out according to the
IBM PC Code on page 94. For information about code page
switching, refer to your DOS manual (DOS command mode device
code page). A table on page 94 shows all characters that can be
correctly converted. Characters not included in that table are
converted into blank spaces.

Converting Word Processing Files to a PC Format

* WP TEXT.WPT—ASCILTXT(Text Only)
* WP TEXT.WPT—ASCIL.TXT(Text with Layout)

You may want to use the information you create with the Word Processing
program on a PC. To do this, you must first convert the Word Processing
file into the ASCII format. Once this is done, you will be able to import
the ASCII file into most word processing programs available on PCs.

An ASCII {(American Standard Code for Information Interchange) file
consists of printable information with no special formatting codes for
underlining, boldface, etc. These special formatting features, such as
underlining, do not translate correctly between your desktop publisher
and a computer. Therefore, when a file is converted to ASCII, all special
formats are eliminated. Once the file is transferred, the file must be
reformatted and any special effects must be added.

An ASCII file can include some formatting codes like carriage returns and
tabs. When you convert a Word Processing file into an ASCII file, you can
select one of the following:

e Text Only removes zll formatting except TAB and RETURN from the
file. When you import such 2 file into a personal computer or a2 word
processing system, the text automatically adapts to the format of the
PC word processing program.

s Text with Layout preserves some of the format of the file. A return is
added at the end of each screen line.

However, if the margins of your original file are unusually wide, additional
carriage returns are placed into the file, and reformatting is necessary.

P To convert files from Desktop Publisher to PC:

1. Press MENU to see the menu bar; select
WP TEXT.WPT—ASCILTXT (Text Only) or
WP TEXT.WPT—ASCILTXT (Text with Layout)
from the Convert menu. The Convert Index dialog box appears:

<< COMVERT INDEX >3 CONVERT (Text with Layouh ] [REMAIN: 1444.8 K] [IHs]irdsuin]

LETTERL JWFT 0 O.BD LETTER1O.WPT ¢ 0O.B>
LETTERLIL.WPT ¢ O.5> LETTERZ .WPT ¢ O.E>

Select & file ba convert and press RETURRP. Fress CRMCEL o 2uail

File Management 91



Once a file is in ASCHi format,
you can recall that file into a word
processing program on a PC.

2. The index shows only Word Processing (. WPT) files. Press the arrow
keys to select the file you want to convert and press RETURN. 7his
message appears:

lInsert destination disk and press RETURN.

3. Insert the destination diskette and press RETURN, or press RETURN
if you want to store the converted file on the same diskette. This
dialog box appears:

LK CONVERT >>
Existing File(s) ¥

Type filenarme and press RETURMN, Press T, 4 to scrall file directary.

This dialog box shows the ASCII files ((TXT) on the current diskette.
The dialog box also provides an entry field for you to type a new
file name. When you type the first letter of the file name, a list appears
that staris with the file alpbabetically closest to that letter. It
automatically scrolls to make sure you do not enter an existing file
name. To see another file name, scroll manually using T or {.

4. Type a file name that is not in use on the current diskette and press
RETURN to convert the file. During conversion, the message
“Working ...” appears. When conversion is complete, the Desktop
Publisher asks you to reinsert the source diskette.

5. To convert another file, insert the source diskette and continue
converting. To return to File Management, press CANCEL.

Converting PC Text Files to Word Processing Files

» ASCILTXT—WP TEXT.WPT

You may want to use text created on a PC with the word processing
program. To do this, you must first convert the text file from the PC into
ASCII format. Most PC word processing software allows you to save a file
as an ASCII text file.

You must also remember that your Desktop Publisher can only use
diskettes formatted to DOS 1.44 MB or DOS 720 KB. If you plan to move
information from a PC to your Desktop Publisher, you must be sure that
the diskette containing the file is formatted to DOS 1.44 MB or DOS 720
KB.

You can format your diskettes to DOS 1.44 MB or DOS 720 KB on a PC
or on your Desktop Publisher. Your PC manual should list the steps to
complete this operation.

The ASCII file must also be stored in the root directory of the diskette and
its file name extension must be .TXT.
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Once a file is converted to
Desktop Publisher’s format, you
can go to the file with the Word
Processing program.

P To convert files from PC to Desktop Publisher:

1. Insert the diskette containing the ASCII file into the disk drive. Press
MENU to see the menu bar; select ASCIL.TXT—WP TEXT.WPT from
the Convert menu. Press RETURN. This dialog box appears:

<KX COMVERT INDEX =5 IREMHIN: 708.6 Klﬁk @

Select afila to convert and press B, Prezs CORICEL bo 2nit,

<< CONVERT INDEK >3 [FEMAN: 14402 K] (NS]HuMiEH]

LETTER1 .THT

Salect afile to conwert and press RETURN. Frezs CRMNCEL to axit,

2. The index shows only ASCII ((.TXT) files. Press the arrow keys to
select the file you want to convert and press RETURN. 7his message
appears:

Ensert destination disk and press RETURN.

3. Insert a destination diskette and press RETURN; or press RETURN if
you want to store the converted file on the same diskette. This dialog
box appears:

<< CONVERT >> FILENAWME: LETTER1_.WPT [REMAIN: 1415.6 K] [OveR[nUMi[sHIT]
[~/ EHisting Féle(s) Y
LETTERL .WRT ¢ ©€.4)

Type filename and press RETURM. Fress 7, & to scroll file directary.

The dialog box above shows the Word Processing files (WPT) on
the current diskette. The dialog box also provides an entry field for
you to type the new file name. When you type the first letter of the
file name, a list appears that starts with the file alphabetically closest
to that letter. The list automatically scrolls to make sure you do not
enter an existing file name. To see another file name, scroll manually
using T or .

4. Type a file name that is not in use on the current diskette and press
RETURN to convert the file. During conversion, the message
“Working ...” appears. When conversion is completed, the Desktop
Publisher asks you to reinsert the source diskette.

5. To convert another file, insert the source diskette and continue
conversion. To return to File Management, press CANCEL.
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IBM PC Code

The following table shows the printable characters that can be correctly
translated when you convert to or from ASCII files on your Desktop
Publisher. Empty cells in this table correspond to control codes or
characters that are converted into blank spaces.

o[1[2]|3l4a]|s5]|e|l7[8]|9]|A|B|C|D|EIF
0 ole|P|~|p|[C|E|A al=
1 tlt1lAa]lala|lqful]ael|l Bl =
2 “l2[B|R]|b|r|6|E]|S r
3 #13]|cls|c|s]ala]u x
4 s|a|lD|T|d|t]|a|o]|n =
5 %|5|E|U|e|lula]o|N g
6 als|Flv]flv]alala m
7 171G | Wlgiw]ge|lu]?® T
8 (IsfH]X]|hix]|e&e |y !¢ @
9 ylofiJy|lilyl[e]o e
A « 1 1Jlzljlz]2a]|U Q
B + sk k[U]T]e|% 3
C <Ll je|n o
D =M1 m[} [0 [¥]i ¢
E > |N| A~ n ~ | A|Pt] « £
F ;12]0]_]o Alrl|»
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4 Applications
-

Using Graphic Art Print
Z‘:’g&i ;r‘;;fﬂs T;’h; S{;i!;’;g The Graphic Art Print software allows you to print black and white and
must be inserted and Graphic Art color graphics. Tl*fese graphic§ are stored on Diskette 1. You can select
Print (GRARTPRT.APL) selected  8Taphics from various categories and print them in normal, half, or double
before you can view graphics size.
{color or black and white),
These graphics print directly onto your paper. They are not saved as part
of a word processing file. To use a graphic as part of a document, print
the graphic onto the paper; then re-insert that paper for printing your text.
These graphics allow you to create such documents as personalized
letterheads, fancy invitations, and newsletters.

If you use special IRON-ON transfer paper, you can iron the graphic
image onto white or light-colored fabrics that are 100% cotton or
cotton/polyester blend, e.g., T-shirts, aprons, nightshirts, baseball shirts,
and pillowcases.

pTo print a graphic image on paper:
1. Turn on the power to see the Main Menu.
2. Insert Diskette 1 into the disk drive.

3. Press 4 to select Graphic Art Print. The grapbic image files appear.
You must use the color ink cartridge to print color graphics.

4. Press the arrow keys to select the graphic you want to print; press
RETURN. The Graphbic Ant Print dialog box appears:

FILENAME: CAIRC .BIM =
FRINT $I1ZE: PAPER SIZE: LETTER ¥. 0.60
REPEAT PRINT: NO PRIMT QUALITY:  MEDIUM ¥ 328

HUMBER OF COPIES: 1 MIRROR PRINT: NO
Fress SPACE to change satling.

Frezs TAB to set printing position. Press RETLIRM to print.

5. Press T and ! to move the cursor to a setting. Press SPACEBAR to
change the settings or type in values.

* PRINT SIZE:
NORMAL—Prints the graphic at actual size
HALF SIZE—Prints the graphic at half width and half height
DOUBLE SIZE—Prints the graphic at double width and double

height
When you sslect REPEAT * REPEAT PRINT:
PRINT:YES, the maximum number . hi
of images that can print within the NO — Prints one graphic
width of the specified paper are YES — Prints multiple copies of a graphic
printed.

¢ NUMBER OF COPIES: The number of times the paper prints
(maximum 999)

* PAPER SIZE: The paper orientation and size to be printed

* PRINT QUALITY:
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The size of the cursor reflects the
size of the selected information.

The cursor can move anywhere
within the selecfed paper size.

When you select REPEAT

PRINT/YES, the cursor moves in
a vertical direction only.

Using Frame Print

FINE—For final quality printing
MEDIUM—For average quality printing
DRAFT—For trial printing. With this setting, you save time and
ink.
* MIRROR PRINT:
NO—For normal printing
YES—For printing the graphic with a reversed image. Mirror

printing is useful when printing graphics on the iron-on transfer
paper. We recommend using Brother iron-on transfer paper.

6. Press TAB to set printing position. The cursor appears in the right
box.

FILENAME: CAIRC .BiM

PRINT S1ZE: NCORMAL PAPER SIZE: LETTER 3.80
REPEAT PRINT: NO PRINT QUALITY:  MEDIUM 328
MUMBER OF COPIES: 1 MIRROR PRINT:  NO '

tove cursor to sebprinting position.

Fresz TAB to change print zettings. Prezs RETURDM ke print

7. Place the cursor where you want to position the graphic and press
RETURN. If you select a black and white graphic file and the color
cartridge is inserted, this dialog box appears:

<< COLOR >>»

Fress SFQICE o change setling and prass RETLUIRM,

8. Press SPACEBAR to change the setting; press RETURN.

If you select the color graphic file and the monochrome cartridge is
inserted, this message appears:
Replace the cartridge and press RETURN.

9. Set your paper according to the size you set in the Graphic Art Print
dialog box. Press RETURN to start printing. 7his message appears:

Printing....prass CANCEL to stap printing.

10. Press CANCEL to stop printing. This dialog box appears:

OK ta cancel printing?
Use cursor to select and press ARETURN.
INDY

Select YES to cancel printing or NO to continue printing.

This feature prints a frame as a border in your document. These frames
print directly on your paper and are not saved as part of a word
processing file. Instead, to frame a document, you will print the frame on
the paper and then reinsert the paper to print your document.
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pTo print a frame:

1. Turn on the power to see the Main Menu.
2. Press 5 to select Frame Print.

3. Insert the color ink cartridge if you wish to print the frame with
color. The Frame Print dialog box appears:

DESIGN: [7Z NUMBER OF COPIES: __ 1
PAPER §IZE: LETTER
N PRINT GUALITY: MEDIUM

25z

Fress T, 4 to selectimage and press RETURM.
Fress

55+, &+ bo roove to another zetting.

4. Press « and — to move the cursor to a setting. Press T, |, or

SPACEBAR to change settings or type in values.
Select FRAME TYPE and then

DESIGN * FRAME TYPE: An icon shows an example of each type of frame
. ¢ DESIGN: An icon shows an example of each type of design

* NUMBER OF COPIES: The number of times the paper prints
(maximum 999)

* PAPER SIZE: The orientation and size of paper to be printed
» PRINT QUALITY:
FINE—For final quality printing
MEDIUM—For average quality printing
DRAFT—For trial printing, With this setting, you save time and
ink.

5. Press RETURN to enter the settings of the Frame Print dialog box. If
the color cartridge is inserted, this dialog box appears:

<< COLOR »>

Press SPACE to change setting and prasz RETURRM.

Press SPACEBAR to change the setting and press RETURN. The
frame information will be printed out.

r Printing . . . press CANCEL to stop printing. J

Press CANCEL to stop printing. This dialog box appears:

OK to cancel printing?

Use cursor ta select and press k-
[VES] [NO]

Use cursor to select and press RETURN.
TES]) INOI

[

OK to cancel printing? J

Select YES to cancel printing or NO to continue printing.
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About Template Files

A template is a file that contains a predefined format for a type of
document. Some example templates include purchase order forms, fax
cover sheet forms, and party invitations.

To use a template, open the template file, make any changes you would
like, and then save the revised file under a new file name. You cannot
change the original template file. You can use these templates over and
over again.

When a template file is opened, the file name extension is replaced, but
the file can be edited in the same way as a normal WPT or MRG file.
Make sure you save the new file with a new file name.

The first template file is named README. Refer to this file for a complete
list of all template files contained on your diskette.

p-To open a template file:
1. Turn on the power to see the Main Menu.
2. Insert the Template diskette into the disk drive.

When a template fite is opened, 3. Select Word Processing or Addressbook; press RETURN. The File
the file name extension is Index screen shows the list of template files.

replaced, and the file can be

edited in the same way as a The template file name extensions are:

normal WPT or MRG file. When . WP]. . Word PI‘OC&SSing

saving, save the file with a new

file name. * MR1 — Addressbook

i ith di nsions do not appear on the File index
Open and read the template file Files with different file name extens pp

named README first. This file is dialog box.
a list of all template files on
diskette.

Using Disk Applications

Disk Application allows you to start an application (program) that is not
built into the system but which comes on a separate diskette. From Disk
application, you can run a tutorial program that teaches you how to use
the word processing program.

pTo use the tutorial:
1. Turn on the power to see the Main Menu.
2. Insert Diskette 1 into the disk drive.
3. Press 6. A list of programs on the diskette appears on the screen.
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<< DISK APPLICATION => [remaiN: 767.4 K| [overfinurilsainT)

ELHEJIACK .APL ¢ B2 2 POKER -.APL { B3.5>

TUTOR WAPL ¢ 27.7)

Seizcta file and press RETURDM. Press CANCEL to display RIAIN WMERIL

4. Select a program and press RETURN. The program starts.

5. Follow the instructions shown on the screen.
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Appendix

Graphic Art Images

There are 20 black and white (monochrome) graphic art images and 20
color graphic art images stored on the Graphic Art Images diskette. These
images allow you to create personalized special items as letterheads, fancy
invitations, and newsletters. The 20 black and white graphic art images
and 20 color graphic art images are shown on the following pages. The
file number of each border or graphic appears at the bottom of each
graphic.
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Black & White Graphic Art Images

MANNOUNC

MBABY IBALOONS
Congratulations!
MBORDER1 MCHURCH MCONGRAT
L " 3 /
P FREE! 7 1| 3
MFIRECRK MFREE MGRAND
MNEW MPARTY MSALE MVALENTN MWREATH
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Color Graphic Art Images

CBOOK

CBSKTB02

CCLICHO5

CCRNRC

CDANCE

CFLWRCo02

CFOOTBO02

CGRAD

CHALLW

|CHBALN

CHOUSE

CNEWYRT1

CNEWYR2

CSAIL02

CSANTA

CSCHMS05

CXMAS

CXMSTX
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File Conversion

Converting Files

This PC program allows you to convert word processing files (such as WordPerfect and Microsoft Word)
to a Desktop Publisher word processing format or from Desktop Publisher to another word processing
format. This diskette contains conversion software that runs on a PC.

CAUTION:

Practically all formatting, text enhancement, and other control
codes are correctly translated so that little or no touching up of the
converted document is necessary. However, in some cases, the
translation results are not as accurate as we would like them to be.
We recommend that you review each file after the conversion is
done to check for any irregularities.

The Brother Conversion software (on diskette) takes files created by one
word processing program (source files) and converts them to Desktop
Publisher files (destination files), and vice versa.
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See the chart below for possible Desktop Publisher to PC conversions:

Convert From To

Ami Pro

ANSI (document oriented)
ANSI (printer oriented)
ASCil (document oriented)
ASCII {printer oriented) .
Brother WP (Daisy Wheel)
Brother WP {(Notebook)
Brother WP (Ink Jet)
Brother WP (SPN/UK}
Brother WP (SPN/France)
HTML

MS Word for DOS 3.0

MS Word for DOS 4.0

MS Word for DOS 5.0

MS Word for DOS 5.5

MS Word for Macintosh
MS® Word for Windows 2.0
MS® Word for Windows 6.0
MS® Word for Windows 7.0
MS® Works 1.0 (DOS)
MS® Works 2.0 (DOS)
MS® Works 3.0 {(Windows)
MS Write

| WordPerfect® 5.0
WordPerfect® 5.1
WordPerfect® 5.2
WordPerfect® 6.0

| WordPerfect® 6.1
WordStar® 5.0
WordStar® 5.5
WordStar® 6.0
WordStar® 7.0

Brother
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ASCII stands for American Standard Code for Information Interchange.
ANSI stands for American National Standard Institute. Like an ASCII text
file, an ANSI text file contains only printable characters, spaces, carriage
returns, line feeds, tabs, backspaces, form feeds, and possibly an
end-of-file code. ASCII (printer oriented) and ANSI (printer oriented) files
are suitable for sending to a printer that supports backspace and form
feed functions.

See the chart below for possible PC to Desktop Publisher conversions:

Convert From To
ASCII (document oriented)

Ami Pro

Brother WP (inkjet)

Brother WP (Daisy/Notebook)
Brother WP (Daisy/Notebook)
Display Write

First Choice®

IBM DCA/DFT

MS® Word™ (DOS)

MS® Word™ {Macintosh)
MS® Word™ (Windows)

MS Works (DOS) Brother
MS Works {Windows)

Multimate
pfs:Write/Pro®Write/1stChoice
Professional Write

Spinnaker Write

WordPerfect® 5.0 (DOS/Windows®)
WordPerfect® 6.0 (DOS/Windows®)
Word for Windows®

WordStar® 3.x — 7.0

Writing Assistant

Installing and Starting the Brother Conversion Software

We recommend that you make a copy of the Brother Conversion software
diskette before you start the installation. You can work from the copy made
and keep the original diskette in a safe place for possible future use.

Computer system requirements
The Brother Conversion software runs on any computer using Windows
3.x or higher (including Windows/NT and Windows 95). (It does not run
on the Desktop Publisher.) The computer must have at least one floppy
disk drive and a hard disk drive. The software imposes no special memory
or other requirements.

pTo install Conversion software under Windows 3.x.:

1. From your Windows desktop, double click on the Main group, then
double click on File Manager in this group to start it.

2. Insert the Brother Conversion diskette in your floppy disk drive and
select the drive in File Manager.
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3. Double click on SETUP.EXE on this disk.

This starts the Brother Conversion software Setup program,

Respond to the dialog boxes on the screen. The Brother Conversion
software will be installed on your hard disk drive.

The Setup program creates a Program Manager group named

Brother. In this group, it places the icons for Conversion software
and On-Line Help.

P To install Conversion software under Windows 95:

1. On your Windows 95 desktop, double click on My Computer.
2, Insert the Brother Conversion diskette in your floppy disk drive and
double click on that drive in the My Computer window.

3. Double click on the SETUP icon on this disk.

This starts the Brother Conversion software Setup program,

Respond to the dialog boxes on the screen. The Brother Conversion
software will be installed on your hard disk drive.

The Setup program creates a Program group named Brother under
Program in the Start menu. In this group, it places entries for
Conversion software and On-Line Help.

Starting Conversion software

1. Each time you want to start the Brother Conversion software, double
click on Conversion software located in the Brother group. This
starts Brother Conversion software, and the Main Panel appears.

2. Click File(s) in the SOURCE area of the Main Panel and select the
files to be converted. If necessary, also click Format to indicate the
source file type. If Format is clicked, the Format Source screen
appears.

If Auto is selected, the system automatically determines the kind of
file format that you selected.

3. Click File(s) in the DESTINATION area of the Main Panel to supply
the path and file name for the target file. If necessary, also click
Format to indicate the source file type. If Format is clicked, the
Format Destination screen appears.

To specify various options that determine how the conversion
program operates, click on the check box in the OPTIONS area of
the Main Panel.

The More Option button brings up an additional panel that lets you
specify even more options.

To see the queue of files to be converted, click on the File Queue
button.

4. Click Convert to convert the file (or files).

The selected file will be converted to the specified format
automatically.

5. If desired, click View Log to see the conversion log.
6. Click Exit to close the program.
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Conversion Steps

STEP 1

PC — Brother
{(From PC to Brother)

Select the PC word
Processing format you
need to convert from. The
files will be converted to
Brother format.

OR

Brother —» PC
{From Brother to PC)
Select the word processing

format your Brother file will
be converted to.

STEP 2

Source

AutoSelect
Drive
Directory
File(s)

Selsct the file(s) you need
to convert, and where those
files are located.

STEP 3

Destination
Location

File Name(s)

Choose where your
converted files will be
saved.

STEP 4

Convert

Begin the conversion
process.
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Extra Character Table
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Symbol Table
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Troubleshooting

Your Desktop Publisher has been manufactured to give you years of trouble-free use. In the rare
instance that problems occur, you may find the solution in the table below. If you cannot, do not
attempt to repair the Desktop Publisher yourself. Instead, please contact your local Brother Service
Center. (For a list of Brother Service Centers, refer to the Brother Authorized Service Center booklet that
comes with your Desktop Publisher.)

Probiem

Solution

Nothing works after the
Desktop Publisher has
been tumed on.

Check that the Desktop Publisher is piugged into a power source.

Printout is impossible or
difficult to read.

Check that the inkjet cartridge is installed correctly. (Please refer to Installing/Re-
placing an inkjet cartridge on page 10.)

Check that there is ink in the cartridge.

Press CODE + SHIFT + INK CHG to clean the print head. If printout is still difficult
to read, press CODE + INK CHG. After the print head moves to the left, replace
the inkjet cartridge. Then press RETURN to clean the print head. Repeat this
operation several times if necessary.

Back of paper is stained
with ink.

The main roller is stained. Feed two or three sheets of paper through the printer to
clean the roller.

Ink runs on the paper.

Try printing on the other side of the paper. If this does not solve the problem, try
other types of paper.

White horizontal lines
appear in the printed text.

The printer and the print head on the cartridge are not properly connected. Remove
and reinsert the cartridge. {See Replacing the Inkjet Cartridge for more informa-
tion.)

Paper jams.

There are two ways to remove jammed paper.

1. Remove the jammed paper manually.
2. Press CODE + SHIFT + CANCEL or CODE + SHIFT + HELP to eject the

papers.

All seems normal after the
Desktop Publisher has
been turned on, but noth-
ing appears.

LCD model: Adjust the brightness control.
CRT model: Adjust the brightness and contrast control. Check that the signal cable
is firmly connected to the monitor.

Disk drive operation is not
possible.

The diskette has been damaged, or a television set or the monitor is located too
close to the disk drive. Try with another diskette and/or move the Desktop
Publisher.
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Error Messages

Please consult the following table when an error message appears:

Message

Cause

Solution

Check printer! Press
any key to continue.

Malfunction of the
printer mechanism
detected.

Verify that the ink cartridge is firmly installed. Press any key to
erase the message, turn the power off, then on again, and
check to see if the printer moves correctly. if the error
message appears again, press any key to erase the message,
turn the power off, then on again, and check whether the
printer moved correctly. If the error message appears again,
consult your local Brother Service Center*.

in your machine’s
Random Access
Memory (RAM).

Incorrect spec! Malfunction at a Turn off the power and consult your local Brother Service
soldering point Center* immediately.
detected.

RAM down! Malfunction detected | Turn the power off and consult your local Brother Service

Center* immediately.

ink cartridge is not
installed!

The ink cartridge is
not installed on the
machine or the head
of the ink cartridge is
dried.

Press CODE +INK CHG and install the ink cartridge. You can
input/edit/save/load the data even if the ink cartridge is not
installed. If this message appears when the ink cartridge has
been installed, remove the ink cartridge and reinstall it on the
machine properly and press CODE + SHIFT + INK CHG
several times. if the error message appears again, replace the
ink cartridge with a new one.
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Specifications

LCD: 480 x 64 dot

Keyboard: 65 keys

Printer: Built-in color inkjet printer
Print method: 300 x 300 dpi inkjet printing
Print speed: 160 cps (for regular & fine quality printing)
Paper capacity: 9.5 inches
Inkjet Cartridge: Approximately 1,000,000 characters
(inkjet cartridge in regular print mode*)
Font type: Helsinki, Tennessee, Brougham
Font size: 10, 12, 14, 18, 36 point
Memory:
Text memory: 70 KB
External memory: 1.44 MB/720 KB (formatted) 3.5" diskette
Paper Specification:

Cut sheet coated paper: A4, Letter, Legal, Executive

Transparencies A4, Letter

Label Sheet A4, Letter

Envelopes DL, COM-10, C4
Feeder Capacity A4. Letter — 30 sheets

Legal Executive — 1 sheet
Transparencies — 1 sheet
Label sheet — 1 sheet
Envelopes (DL, COM-10) — 5 sheets
Envelopes (C4) — 1 sheet
Paper Selection Lever
Front Transparencies
Envelopes
24 Ib paper
Label sheet
Transfer Iron-on Paper
Back A4 Letter
Legal Executive

Paper Capacity in Feeder

Appendix 112



Sheet Feeder
OQutput Stacker
Paper Weight
Print Width
Line Feed Speed

Printing Direction

Monochrome

Color

approximately 30 sheets of 20 Ib.
approximately 10 sheets of 20 lb.
16 to 24 Ib.

8.1 inches maximum

2.0 inch/second

1/6 inch line feeds

Bidirectional in text
Unidirectional in text more than 14 pt
Unidirectional in Image

Unidirectional

Appendix 113



Margins:

Letter, Legal, A4, Executive

Left .2 inch min
Right .2 inch min
Top .5 inch min
Bottom 1 inch min

Envelopes — US Commercial 10, European DL

Left .2 inch min
Right 1.2 inches min
Top .5 inch min
Bottom .5 inch min
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Glossary

Abbreviated phrase: A function that allows i
i you to enter phrases you use frequently by ¢ iati
rather than the entire phrase. ¢ ! Y (pin an abbreviadon

Accelerator' keys: The underlined letters on function or pull-down menus that can be used as short-cut keys
by pressing the same letter on the keyboard to activate that function on the menu.

Address block: In a letter, the area in which the address of the recipient is shown.
Application: A program such as Word Processing or Addressbook.
ASCII file: A text file consisting of only ASCII codes (all special formatting has been eliminated).

Bacgup: A (cjopy of your data on a separate diskette that you keep in case your original data or diskette is
amaged.

Block: An area of text that you can copy, delete, or move to another part of that document or to another
document in Word Processing or Addressbook.

Bold: Characters that are thicker than normal, or to make characters that are thicker than normal.
Center tab: A tab used to center text at that tab position.

Centering: A Word Processing function that centers text between margins.

Character keys: Keys that produce a letter or symbol.

Chart symbol: A symbol that indicates that there is a chart beginning from that line.

Column: In Addressbook, a vertical group of information that represents one category, such as names or
addresses.

Conversion: Changing computer data into a form that can be used by a different computer system or program.
The Desktop Publisher allows you to convert a Word Processing file into an ASCII file and vice versa.

Cursor: (1) A small blinking box used to select a position on the screen.
(2) A long illuminated block used to select menu items by highlighting them.

Cursor keys: The four keys with arrows on them. When you press a cursor key, the cursor moves in the
direction of the arrow on the key.

Decimal tab: A special tab used to align numbers in a column by their decimal point rather than by the first
character.

Disk Drive: The mechanism that writes data to and reads data from diskettes.

Diskettes: A thin, magnetic-coated disk on which computer data can be stored. The Desktop Publisher uses a
3.5-inch diskette.

Entry field: On the Data Input screen in the Addressbook program, each data entry area.

Extension: Characters added to the end of a file name after a period to identify in which program the file was
created. These extensions contain a period and three letters. Example: .WPT

Extra Character: Foreign language characters, special marks, and common symbols available for use in your
files.

File: The unit in which data is stored on the diskette, for example, a single Word Processing document, or
Addressbook file,

Floppy diskette: Sce Diskettes.

Fomnt: A specific typeface style assigned to the characters. You may use one font or a combination of fonts

within one file. (Tennessee, Helsinki)
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Font Size: The height and width of a character determined by the selected point size (the vertical measurement
of the characters).

Font & Size: Dialog box that allows you to select both the font and the size of the font for typed characters.
Foofter: A line of text that prints at the bottom of every page in a document.

Format: The visual arrangement of text on a page, determined by factors such as margin and tab settings,
justification, and centering.

Format change symbol: A symbol indicating that there was a format change, such as Justify on/off.
Formatting: See Initializing.

Frame: A set of horizontal or vertical lines such as those used in forms and tables.

Function key: A key that initiates a specific operation. The MENU key is an example of a function key.

Function menu bar: A bar that appears across the top of the screen that contains pull-down menu names. You
can access it by pressing MENU.

Graphics: Any non-alpha/numeric image that you add to your document, such as vertical or horizontal lines,
charts, and graphs.

Header: A line of text that prints at the top of every page in Word Processing files.
Help window: A window that shows a list of short-cut keys.

Hyphben scan: A Word Processing function that scans your document for lines of text with long blank spaces
caused by the word wrap function.

Initializing: A process by which the system divides a diskette into sections that organize the storage of your
files. If the diskette contains data, the system deletes it during formatting.

Ink-jet cartridge: An accessory needed to supply ink for printing.
Input/Edit screen: In the Word Processing and Addressbook programs, the screen where you enter data.
Insert mode: The mode in which you can insert text at the cursor while “pushing” other text further on.

Justify: A Word Processing function used to adjust the spacing in each line of text so that left and right margins
are evenly aligned.

Label: A string of characters that identifies each category of information in an Addressbook file.

Label printing: A method for printing Addressbook records on envelope labels.

Leader tab: A tab used to enter a line of dots from the position where TAB is pressed up to the next tab.
Line framing symbol: A symbol indicating that there is a frame beginning on that line.

Line out: A function that quickly erases all characters before the cursor on the current line.

List printing: A method for printing Addressbook records as a list.

Memory: A part of the Desktop Publisher that temporarily stores data. The contents of the memory are cleared
when you turn off the Desktop Publisher.

Merge printing: A function for printing a Word Processing document incorporating Addressbook records (such
as addresses) in desired positions.

Non-character key: Keys that do not provide letters or symbols. Non-character keys activate the functions
indicated on their respective key tops.

Normal tab: A tab used to left—align text with that tab position.

Overwrile mode: The mode in which inserting text at the current cursor position deletes the text at that
position.

Page break symbol: A symbol that ends a page and starts 2 new page.
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Paragraph break: The end of a paragraph formed by pressing RETURN. The paragraph break symbol [.]]
appears.

Permanent byphen: A hyphen to protect words from being separated on two lines. Words with a permanent
hyphen between them are treated as one word.

Permanent space: A space to protect words from being separated on two lines. Words with a permanent
space between them are treated as one word.

Point: The unit used to express the size of characters. 72 points = 1 inch.

Print {’review: A screen illustration of your typed document displayed to give an overall format layout before
printing.

Prompt: A message or format shown on the screen that requires the user to respond.
Pull-down menu: A list of functions that appears below the menu name when the menu name is selected.

Record: One listing in an Addressbook file, for example, the name, address, and telephone number of one
individual.

Right margin flush: The text is aligned with the right margin.

Root directory: The original file directory of a tree structured file system. The root directory exists even if the
user does not make any other directories.

Scale: The line at the top of the screen that shows the horizontal position of the cursor as well as the position
of the right and left margins and tab settings.

Scroll: To move through the data display area quickly when all the data cannot fit on the screen. As old data
disappears from one edge of the screen, new data appears at the opposite edge.

Search: A Word Processing and Addressbook function that finds a specified string of characters.
Select: An Addressbook function that lists data that matches the specified conditions.
Self-demo: A program that shows you examples of Word Processing and Addressbook documents.

Short-cut keys: A combination of keys that activates a function without selecting the function from the
function menus.

Soft byphen: A hyphen entered with CODE + S or inserted with hyphen scan function.

Soft space: A normal space produced by pressing SPACEBAR.

Sort: Reorganizes Addressbook data in either alphabetic or numeric order (or reverse order).

Spell check: A function that checks your text for misspelled words and gives a list of possible corrections.

Status line: The area at the top of the screen showing the name of the file you are working on and other
current settings.

Subdirectory: Directories created by the user that appear below a root file directory or other file directories.
Subscript: Characters printed slightly lower than normal characters.

Superscript: Characters printed slightly higher than normal characters.

Symbols: Special characters that can be included in your documents.

Tab: A key that moves the cursor (and text) to the next preset tab stop. Tabs can align text in various ways. For
example, decimal tab aligns numbers by their decimal points.

Text area: In the Word Processing Input/Edit screen, the range over which you can move the cursor and enter
data.

Tutorial: A program that shows how to use Word Processing.

Type style: An atribute, such as underlining, that is given to your typed text to add effect.
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User dictionary: A list of words not in the Spell Check’s standard dictionary that are typed in by the user. The
Spell Checker consults this when checking spelling in your document.

Word out: A function that allows you quickly to delete the word immediately before the current cursor
position,

Word wrap: Allows you to type a paragraph without continuously pressing return. When a word goes beyond
the right margin, the word moves to the next line automatically.

Write protection: Protects a diskette from accidental erasure. This is done by setting the write-protection
switch on a diskette in the Read Only position.
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block functions, in Word Processing, 51
bold, in Word Processing, 26, 44
botftom record

data input screen, 83

view screen, 73, 74

C
cancal key, 19
caps lock mode, 18
cenfer tabs, 47
centering
headers/faoters, 40
text in Word Processing, 37
character keys, 18
characters, different, typing, 29
characters, extra
description of, 30
table, 109
charts, exampiles, 64
cleaning
bracket contacts in printer, 14
print head, 13
clip art
black and white, 102
color, 103
close file command, 33, 34, 35
code key, 20
color
changing a block of text, 51, 52
frame color §7
graphic art images, 103
headers/footers, 41
in Word Processing, 44
label name, 43
search color function, 32
color mark ON/OFF, in Word Processing, 65
color print, in Word Processing. 67
confrast, LCD screen, &
conversion (on a PC), 104
Brother to PC chart, 105
computer system requirements, 106
dascription of, 23



installing & starting conversion softwars, 106
PC to Brother chart, 106
steps, 108
convetsion software, starting, 107
converting
ASCI file info Brother Word Processing file, 90
Brother Word Processing file info ASCII file, 90
Brother Word Processing files to PC format, 91
PC text file to Brother Word Processing file, 92
copy format, 44, 49
copying, a biock of records, 74
copying
a block of text, 51
a graphic, 53, 59
creating
abar chart, 53, 54
aline chart, 53, 54
a new chart, 53
anew file, 25
a stacked bar chart, §3, 54
cursor keys, 18, 19

decimal tabs, 46
delay printing, in Word Processing, 68
delefe all, 89
deleting
a block of records, 74, 76
a block of text, 33, 51, 62
a character, 33
a format change symbol, 44
a graphic, 53, 5%
a label
data input screen, 83
view screen, 75, 76
a line of text, 33
awotd, 33
data from a chart, 65
lines in a frame, 57, 68
text, 33
directory read, 89, 90
Disk Application, 95
description of, 21
frame print, 96
printing graphic artf, 95
diskettes, 15
backing up, 17
description of, 16
initializing (formatting). 16
inserting, 15
making a backup copy, 86
removing, 15
size and type, 15
write-profecting, 17

edit functions, 37

edit thesaurus, in Word Processing, 60, 65
editing
a chart, 53, 55
a frame, 57
color, 57
enlarging/reducing, 57, 58
an existing file, 25
basic editing, 31
headets/footers, 40
centering, 40
right margin flush, 40
user dictionary, 63
enlarging, a frame, 57, 58
etror messages, 111
exiting
a frame, 58
spell check, 60
user dictionary, 64
extra characters
description of, 30
fable, 109
F
file copy, B7
file delete, 87, 88
File Management. 85
convert functions, 90
description of, 21
disk functions, 89
delete all, 89
directory read, 89, 90
initialize disk, 89
list print, 89, 90
file functions, 87
file copy, 87
file delete, 87, 88
rename, 87, 88
return to main menu, 87, 88
file management, 33
file name
conventions, 35
extensions, 85
font & size
changing a block of text, 51, 52
headers/footers, 41
in Word Processing, 44
font color, in Word Processing, 26
footers, 37, 40
auto page numbering, 40
editing, 40
exiting, 40
font & size, 41
margins & tabs, 41
styte functions, 41
type style change, 41
format change symbol, deleting, 44
frame



deleting dll lines, 57

enlarging or reducing, 57, 58
function keys, 19
function mark on/off, in Word Processing, 65
function menus, 22

accelerator keys, 22

short cut keys, 22

G
graphics
black & white clip art, 102
clip art, 95
color clip art, 103
copying graphics, 53, 59
creatfing a new chart, 53, 54
deleting graphics, 53, 59
editing charts, 53, 55
line framing, 53
graphics functions, 53

headers, 37, 40

auto page numbering, 40

editing, 40

exiting, 40

font & size, 41

margins & tabs, 41

style functions, 41

type style changs, 41

headets and footers, color 41
Help Menu, using the , 25
help windows, 22
hot zone, hyphenation, 41
hyphen scan, 37
hyphen, fypes of, 28

normal hyphen, 28

permanent hyphen, 28

soft hyphen, 28
hyphenation hot zone, 41

IBM PC code 880, 94
indent
paragraph indent, 29
tab indent, 29
initiclize diskette, 89
ink-jet cartridge
description of, ¢
installing, 10
replacing, 11
input/edit, screen, text area (Word Processing), 27
inputfedit screen
in Word Processing, 26
scale (Word Processing), 27
insert, in Addressbook, 74, 75
Insert label

data input screen, 83
view screen, 76

insert mode, 32

inserfing text, 32

J

justify, text in Word Processing, 37, 38

keyboard, 18

keypad, 19

keys
arrow keys, 31
cancel, 19
character keys, 18
code, 20
cursor keys, 18
function kays, 19
lotter keys, 18
menu key, 20
refurn key, 19

L

label settings, in Addressbook, 79

labels
change name & width, 76, 83
change name and width, 75
change print settings, 78, 81
changing page setup, 80
merge printing, selecting records, 82

layout ’
in Word Processing, 66
previewing a document, 69

leader tabs, 47

legend (in charts), 54

letfer kays, 18

line framing, 53, 56

line indent, 47

line spacing, in Word Processing, 44

" lines, deleting in a frame, 58

list print, 89, 90

main meny, 21
margins & tabs
headers/footers, 41
in Word Processing, 44
menu key, 20
merge code, 37, 42
merge printing
in Addressbook, 82
in Word Processing, 67, 69
moving
a block of records, 74
a block of text, &1
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rmulfi-cokamn search color function, 32

in Word Processing, 44 select, in Addressbook, 77
fyping text, 49 Self Demo, 22
setup, 4
N shift key, 18
new record shiff lock mode, 18
data input screen, 83 short cut keys, 22
view screen, 73 soft hyphen, 28
normal hyphen, 28 soft spaces, 28
normal tabs, 46 sort, in Addressbook, 77
number lock mode, 19 spacebar, 18
' spaces, types of, 28
o psrmanent spaces, 29

soft spaces, 28
special characters, 29
specifications, 112

open file command, in Word Processing, 33
overwrite mode, 32

P spell check
capiftalizafion mistakes, 62

page break, 29 during typing. 60, 62
page numbering, 40 in Word Procsessing, 60
page setup, in Word Processing, 44, 50 misspelled words, 60
papetr, recommended paper quality, 6 starting an application, 21
paper feedet, § status line, in Word Processing, 26
paragraph break, 29 supplemental programs, 23
paragraph indent, 29, 47 . convetsion, 23
permanent hyphen, 28 tutorial, 23
permanent spaces, 2¢ symbol table, 109
previewing a document, 69 symbols, 30
print head, cleaning, 13 table, 109
print gquality, in Word Processing, 66
print record on/off, in Addressbook, 78 T
printing falb indent, 29

a list, in Addressbook, 80 tabs

all file names on diskette, 89, 90 center tabs, 47

delay printing. 68 creating a line indent, 47 _

in Addressbook, 76 creating a paragraph indent, 47

in Word Processing, 66 creating a table, 46

labels, in Addressbook, 78 decimal tabs, 46

merge printing, 69 leader tabs, 47
Printing all file names. on diskette, 89 normal tabs, 46

text
R delefing, 33
reducing. a frame, 58 inserting, 32
reducing a frame, 57 text areq, 27
rename file, 87, 88 top record
replace, in Word Processing, 37, 39 data input scieen, 83
return key, 19 view screen, 73, 74
return to main menu, in File Management, 87, 88 troubleshooting, 110
return to view screen, in Addressbook, 84 : tutorial, 23
right margin flush, in Word Processing, 37 type style add, changing a block of text, 61, 62
type style change
s changing o block of fext, 51, 52

in Word Processing, 44
type thesaurus, in Word Processing, 60, 64
typing

basic, 28

different characters, 29

save file, in Word Processing, 33
scale line on/foff, in Word Processing, 65
search

in Addressbook, 83

in Word Processing, 37, 38



text in multi-column pages, 49
typing different characters, 29

U
user dictionary
adding a word, 63
delsting a word, 63
loading « file, 43
editing, 63
exiting, 64
in Word Processing, 62
saving, 64
user dictionary maintenance, in Word Processing, 60

W

Word Processing, 25
auto page numbering, 40
block functions, 51
color, 51
copy, 51
delets, 61, 52
font & size, 51
move, 51
type style add, 51, 52
type style change, 51, 52
color mark ONfOFF, 65
color printing, 67
delay printing, 68
description of, 21
edit functions
centering, 37
footer, 37, 40
header, 37, 40
hyphen scan, 37
justify, 37, 38
merge code, 37, 42
replace, 37, 39
right margin flush, 37
search, 37, 38
editing a frame
color, 57
delets ali, 57
exit, 57, 68
example charis, 54
file functions, 33
close file, 33, 34, 35
filte management, 33, 36
save file, 33
file menu, open file, 33
graphics functions, 53
copying a graphic, 53, 59
create new chart, 53
deleting a graphic, 63, 59
delefing data from a chart, 556
edit chart, 53, 55
line framing, 53, 66
input/edit screen, 26

scale, 27
status line, 24
line framing, editing a frams, 57
merge printing, 67, 6%
option functions, 40
check during typing on/off, 60, 62
edit thesaurus, 60, 656
spell check dll, 60
type thesaurus, 60, 64
user dictionary maintenance, 60, 62
print functions, 66
layout, 66
print, 66
print quality, 66
screen functions, 65
function mark on/off, 65
scale line on/off, 65
style functions, 44
color, 44
copy format, 44, 49
delete format, 44
font & size, 44
ine spacing, 44
margins & tabs, 44
multi-column, 44
page setup, 44, 50
type style change, 44
word wrap, 28

X

x-qxis, 54

Y

y-axis, 54

Index 123



Index 124






brother.

US3059001
Printed in USA



	Cover DP525CJ
	Table of Contents
	Getting Started
	How to use this Manual
	Parts of your Desktop Publisher
	Precautions
	Setup
	Paper Feeder
	About Landscape Printing

	Inkjet Cartridge
	Installing/Replacing an Inkjet Cartridge
	Cleaning the Print Head

	Diskettes
	Inserting and Removing a Diskette
	Initializing (Formatting) New Diskettes
	Write-Protecting your Diskettes
	Backing Up a Diskette

	Keyboard
	Character Keys and Arrow Keys
	Keypad Keys
	Function Keys

	Selecting Programs
	Main Menu
	Function Menus
	Help Windows
	Self Demo

	Supplemental Programs
	Conversion
	Tutorial


	Word Processing
	Using the Word Processing Input/Edit Screen
	Using Basic Typing Features
	Word Wrap
	Hyphen
	Types of Spaces
	Paragraph Break
	Page Break
	Tab and Paragraph Indent
	Typing Different Characters

	Using Basic Editing Features
	Moving the Cursor Using Arrow Keys
	Search Color Function
	Inserting Text
	Deleting Text

	Using the File Menu
	Tips for using Files
	Close File
	Saving a File
	File Management

	Using the Edit Menu
	Using the Style Menu
	Using the Block Menu
	Using the Graphics Menu
	Using the Option Menu
	Check during Typing ON/OFF (Spell Check)
	User Dictionary Maintenance

	Using the Screen Menu
	Scale Line ON/OFF
	Function Mark ON/OFF
	Color Mark ON/OFF
	Using the Print Menu
	Using Layout to Preview a Document


	Addressbook
	Using Addressbook Screens
	View Screen
	Data Input Screen

	Working with Addressbook
	File Menu
	Input Menu (View Screen)
	Record Menu (View Screen)
	Label Menu (View Screen)
	Edit Menu (View Screen)
	Print Menu (View Screen)
	Using Customized Labels
	Jump Menu (Data Input Screen)
	Label Menus (Data Input Screen)
	Screen Menu (Data Input Screen)


	File Management
	Making a Backup copy of a Diskette
	Using the File Menu
	Using the Disk Menu
	Initialize Diskette
	Directory Read
	Using the Convert Menu
	Converting Word Processing Files to PC Format
	Converting PC Text Files to Word Processing Files

	IBM PC Code

	Applications
	Using Graphic Art Print
	Using Frame Print
	About Template Files
	Using Disk Applications

	Appendix
	Graphic Art Images
	Black & White Graphic Art Images
	Color Graphic Art Images
	File Conversion
	Converting Files
	Installing and Starting the Brother Conversion Software

	Extra Character Table
	Symbol Table 
	Troubleshooting
	Error Messages
	Specifications

	Glossary
	Index
	Rear Cover


